
Reflection FTP Client

User Guide

21.1

© 2023 Open Text 

Reflection FTP Client



Table of contents

6Reflection FTP Client

7Introduction

7Introduction

8Connect to FTP Site Dialog Box

9View the Local PC Files

10View the Server Files

11FTP Client Settings Files

12Options for Automating FTP Client Transfers

13Connecting to an FTP or SFTP Server

13Connecting to an FTP or SFTP Server

13Connect to a Site

14Add a New Site to your Connection List

15View Connection Information

15Preserve a Connection to a Server

16Secure FTP Client Connections

34Working with FTP Client Settings Files

34Working with FTP Client Settings Files

35Save your FTP Client Settings

36Load Saved FTP Client Settings

37Import FTP Client Settings

38Import WS_FTP Settings into FTP Client

38Save Changes on Exit Dialog Box

39Export FTP Settings Dialog Box

41Configuring Site and Global Properties

41Configuring Site and Global Properties

42Change Global Settings for the FTP Client

48Change Settings for an FTP or SFTP Site

66Transferring Files

66Transferring Files

67Transfer Files with FTP Client

Table of contents

Table of contents 2



68Set the Transfer File Type (Transfer Method)

69Add a Smart File Transfer Type

71Specify a Default Smart File Transfer Type

71Handle Existing Files (Transfer Mode)

73Set Time and Date of Downloaded Files

74Transfer Files between Two Remote Sites

75Change the Filename when Downloading

76Change the Filename when Uploading

77Resume an Incomplete Server File Download

79Character Sets Dialog Box

82Add Smart File Type Dialog Box

83Smart Transfer File Type Dialog Box

84Confirm File Replace Dialog Box

86Managing Files and Folders

86Managing Files and Folders

87Working with Files

88Working with Local Folders

89Create a Shortcut to a Local File or Folder

90Working with Server Directories

91Set Default Home Directories

93Working with Filename Characters

95Filter the Server File Listing

97Run the Directory Definition Wizard

98Set File and Directory Permissions

100Server View Filter Dialog Box

100Server File Properties Dialog Box

102Go To Folder Dialog Box

103Customizing FTP Client Startup

103Customizing FTP Client Startup

104Create a Shortcut to Load a Settings File

104Create a Shortcut to Connect to a Site

105FTP Client Startup Switches

107Startup Command Examples

Table of contents

Table of contents 3



108Run a Script File at Startup

109Example of Starting the Client with a Script File

110FTP Client Troubleshooting

110FTP Client Troubleshooting

111Identifying the Source of the Problem

112Troubleshooting FTP Client Connections

114Troubleshooting FTP File Transfer Problems

115Troubleshooting FTP Directory Listing

116Secure Shell Log File

117Troubleshooting FTP Site-to-Site Transfer

119FTP Client Error messages

122Windows Sockets Error Messages

125Error Messages

127Using the FTP Command Window

127Using the FTP Command Window

127The FTP Command Window

129Clear the Command Window

130Use the FTP Command Line

131FTP and SFTP Command Syntax

132Quotation Marks in FTP or SFTP Commands

133FTP Scripting

133FTP Scripting

134FTP Client Scripting

135Record a Script

136Run a Script

136Edit a Script

137FTP Client Script File Format

138Which Actions Are Captured by the Script Recorder?

141Password Security within Scripts

142Commands for Error Handling

143Running a Script as a Background Task

Table of contents

Table of contents 4



144Creating Script Log Files

145Command Reference

145Command Reference

146FTP commands

196SFTP commands

215Legal Notice

Table of contents

Table of contents 5



1. Reflection FTP Client

You can use the FTP Client to transfer files between the local computer and a remote host. The

client supports transfers to and from both FTP and SFTP (SSH) servers. Reflection FTP Client

enables you to connect to FTP sites and quickly transfer files using the FTP protocol. It includes the

following features:

A split pane view allows you to browse for both local and server files. View menu options

allow you to select the display preferences you prefer for viewing files.

Use standard Windows drag-and-drop and copy-and-paste operations to transfer files

between the server and your PC.

The FTP Client supports a variety of security protocols, including SOCKS, SSL/TLS, Secure

Shell, and firewall servers.

The FTP Site Wizard leads you through the listitems necessary to configure your FTP site.

To launch the wizard, click New in the Connect to FTP Site dialog box.

The FTP Client automatically recognizes most common FTP servers. Troubleshooting

options for problem servers include support for creating simplified file lists and the 

Directory Definition Wizard .

An optional command window allows you to view all messages sent between the FTP Client

and server. In this view, you can also communicate with the FTP server by entering standard

FTP commands directly on a command line.

Smart file transfer allows FTP client to automatically recognize which transfer method

(ASCII or Binary) is appropriate for specified types of files.

A script recorder allows you to capture actions you take using the FTP Client as command

scripts and to play back those scripts to automate connections and file transfers.

OLE Automation support allows you to script FTP transfers from external applications.

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 
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2. Introduction

2.1 Introduction

Reflection FTP Client enables you to connect to FTP sites and quickly transfer files using the FTP

protocol. It includes the following features:

A split pane view allows you to browse for both local and server files. View menu options

allow you to select the display preferences you prefer for viewing files.

Use standard Windows drag-and-drop and copy-and-paste operations to transfer files

between the server and your PC.

The FTP Client supports a variety of security protocols, including SOCKS, SSL/TLS, Secure

Shell, and firewall servers.

The FTP Site Wizard leads you through the listitems necessary to configure your FTP site.

To launch the wizard, click New in the Connect to FTP Site dialog box.

The FTP Client automatically recognizes most common FTP servers. Troubleshooting

options for problem servers include support for creating simplified file lists and the 

Directory Definition Wizard .

An optional command window allows you to view all messages sent between the FTP Client

and server. In this view, you can also communicate with the FTP server by entering standard

FTP commands directly on a command line.

Smart file transfer allows FTP client to automatically recognize which transfer method

(ASCII or Binary) is appropriate for specified types of files.

A script recorder allows you to capture actions you take using the FTP Client as command

scripts and to play back those scripts to automate connections and file transfers.

OLE Automation support allows you to script FTP transfers from external applications.

More information

Transfer Files with FTP Client

Connect to FTP Site Dialog Box

View the Local PC Files

View the Server Files

FTP Client Settings Files

Options for Automating FTP Client Transfers

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 
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2.2 Connect to FTP Site Dialog Box

The Connect to FTP Site dialog box opens when you start the FTP Client. You can also open it by

choosing Connect from the Connection menu. This dialog box shows all sites that you have

defined and saved to the current settings file.

Connect Connect to the selected site. The client connects using settings you have

configured for that site.

New Add an FTP site. This opens the Add FTP Site wizard.

Properties View or modify the settings for the selected site.

2.2 Connect to FTP Site Dialog Box
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More information

Add a New Site to your Connection List

Connect to a Site

Secure FTP Client Connections

Troubleshooting FTP Client Connections

Connecting to an FTP or SFTP Server

2.3 View the Local PC Files

To work with items on the local PC, use the left pane of the FTP Client. Commands on the File and 

Edit menus, and most buttons on the toolbar, apply to folders and files in the currently active pane.

To view the local PC files

Start the FTP Client.

Click the left pane to make it active.

Use the left pane to browse your files and folders.

More information

Managing Files and Folders

Security Configure secure connections to the selected site.

• • 

• • 

• • 

• • 

• • 

1. 1. 

2. 2. 

3. 3. 

To see and navigate the hierarchy of all folders, go to the active pane, click the Go to a

different folder list box, then choose the folder you want to open.

To change the way files are displayed, go to the active pane and use the commands on

the View menu, or use the four view buttons on the toolbar.

Note

• • 

• • 

• 
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2.4 View the Server Files

To work with items on the server, use the right pane of the FTP Client. Commands on the File and 

Edit menus, and most buttons on the toolbar, apply to folders and files in the currently active pane.

To view the server files

Start the FTP Client and connect to the remote site.

Click the right pane to make it active.

To open a folder or file, or to start a program, double-click it.

To display the contents of a file or run a program, the FTP Client first copies the file from the

server to your default local home folder.

More information

Working with Server Directories

Filter the Server File Listing

Set Default Home Directories

Run the Directory Definition Wizard

1. 1. 

2. 2. 

3. 3. 

3. 

For FTP connections (but not SFTP connections) you can use a file view filter to limit

the current directory listing to files of a specific type. From the View menu, choose 

Filter .

To see and navigate the hierarchy of all folders, go to the active pane, click the Go to a

different folder list box, then choose the folder you want to open.

To change the way files are displayed, go to the active pane and use the commands on

the View menu, or use the four view buttons on the toolbar.

Note

• • 

• • 

• • 

• • 

• • 

• • 

• • 
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2.5 FTP Client Settings Files

The Reflection FTP Client uses settings files to save your configuration. Settings files include the

following information:

All the sites you have configured, including all site properties. If you have elected to save

passwords, these are saved as encrypted text in the settings file.

Your settings for Transfer Method and If File Exists.

Settings that you have configured using the Options dialog box.

By default the client automatically opens a settings file named Settings.rfw  when you start up.

You can create shortcuts to launch the client and automatically open any settings file. The client's

title bar displays the name of the currently open settings file. Settings files use an RFW file

extension.

More information

Working with FTP Client Settings Files

Create a Shortcut to Load a Settings File

Import FTP Client Settings

• • 

• • 

• • 

When you open a settings file, the settings in the file you open replace any currently

configured settings.

You can also use the Import Settings command to modify your client settings. When you

do, imported settings are appended to any currently configured settings and the title of

your session remains unchanged.

Some display preferences are saved to the Windows registry, not settings files. These

settings include your command pane display and your local and server pane view

settings. Changes you make to any of these settings affect all client sessions regardless

of what settings file is open.

Prior to version 13.0, settings were saved in the Windows registry. If you have upgraded

from an older version your settings are migrated automatically to a settings file the first

time you run the client.

note

• • 

• • 

• • 

• • 

• • 

• • 

• • 
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2.6 Options for Automating FTP Client Transfers

The FTP Client provides the following options for automating file transfers:

Use FTP Client scripts to automate connections and file transfers from within the client. For

details, see FTP Scripting and the Command Reference.

Use the FTP Client Automation API to automate transfers from external applications. The

API documentation is available at Reflection FTP Client API.

• • 

• • 

2.6 Options for Automating FTP Client Transfers
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3. Connecting to an FTP or SFTP Server

3.1 Connecting to an FTP or SFTP Server

In this Section

Connect to a Site

Add a New Site to your Connection List

View Connection Information

Preserve a Connection to a Server

Secure FTP Client Connections

3.2 Connect to a Site

You can connect to an FTP or SFTP server in any of these ways:

Use the Connect to FTP Site dialog box that opens when you launch the client.

Create a shortcut that launches a settings file and automatically connects you to a site.

Enter an OPEN command at the FTP command line. For more information, see the Open

topic in the Command Reference.

Start the client with a startup command that runs a script or connects to a server and

performs a file transfer command automatically.

Connect to a second site in the same session using Connect > Connect to a Second Site .

More information

Connect to FTP Site Dialog Box

Create a Shortcut to Connect to a Site

FTP Client Startup Switches

Add a New Site to your Connection List

Customizing FTP Client Startup

Secure FTP Client Connections

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 
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3.3 Add a New Site to your Connection List

Use the Connect to FTP Site dialog box to add new sites to your connection list.

To add a new FTP or SFTP site to your connection list

Start the FTP Client.

This opens the Connect to FTP Site dialog box. (If the FTP Client is already running and this

dialog box is not open, go to Connection > Connect .)

Click New to start the Add FTP Site Wizard .

Type the host name or IP address of the FTP (or SFTP) server and click Next .

Specify whether to log in with a user name or using an anonymous login. (Anonymous logons

are not allowed for SFTP connections.)

(Optional) To configure additional site properties, click Advanced in the Login Information

panel.

(Optional) To configure a secure connection, click Security in the Login Information panel.

If you are configuring a connection for a registered user, you'll see the FTP User Login panel.

Type your user name. You can also save your password as obfuscated text in the settings file.

In the Connect panel, enter a descriptive name for this site. This name is used in the Connect

to FTP Site dialog box.

Specify whether you want to connect to the site now and click Finish .

From the File menu, click Save to save this change to the current settings file.

More information

Connecting to an FTP or SFTP Server

Create a Shortcut to Connect to a Site

Secure FTP Client Connections

1. 1. 

1. 

2. 2. 

3. 3. 

4. 4. 

5. 5. 

6. 6. 

You can also modify the security and other properties later. To do this select the site in the 

Connect to FTP Site dialog box and click Security or Properties .

note

7. 7. 

8. 8. 

9. 9. 

10. 10. 

• • 

• • 

• • 
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3.4 View Connection Information

When you are connected to a host you can display information about the server and the

connection.

To view connection information

From the Connection menu, click Site Properties .

Click the Information tab.

The Information tab provides these statistics:

Some characteristics of the server

The date and time the connection was opened

How long the connection has been active

Duration of the last file transfer operation

Speed of the last file transfer operation

Average speed of all file transfer operations during the current session

Security information about the current session

3.5 Preserve a Connection to a Server

Most servers have an "idle time" value that specifies how long a user's session can last when no

activity is detected. When the user exceeds the time limit, the server connection is closed. To

prevent the server from closing the connection due to inactivity, you can configure the FTP Client to

send "keep alive" commands.

To preserve a connection to the server

Open the Site Properties dialog box and then click the Connection tab.

Select Send keep alive every <n>  seconds and specify how many seconds to wait in between

sending consecutive keep alive (NOOP) commands.

Click OK .

1. 1. 

2. 2. 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

1. 1. 

2. 2. 

3. 3. 

This setting has no effect on SFTP connections. For SFTP connections use Server Keep

Alive on the General tab of the Secure Shell Settings dialog box.

note

3.4 View Connection Information
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3.6 Secure FTP Client Connections

3.6.1 Secure FTP Client Connections

The FTP Client supports a variety of security protocols, including SOCKS, SSL/TLS, Secure Shell,

and firewall servers.

In this Section

Connect Using a SOCKS Proxy Server

Connect via a Firewall

Secure Shell Connections (FTP Client)

SSL/TLS Connections (FTP Client)

3.6.2 Connect Using a SOCKS Proxy Server

Use this procedure to configure connections in the FTP Client if your site uses a SOCKS proxy

server.

To connect using a SOCKS proxy server

Start the FTP Client.

This opens the Connect to FTP Site dialog box. (If the FTP Client is already running and this

dialog box is not open, go to Connection > Connect .)

Perform one of the following tasks:

Click Security .

SOCKS configuration is different for FTP and SFTP connections:

• • 

• • 

• • 

• • 

1. 1. 

1. 

2. 2. 

To Do This

Create a

new site

From the Connect to FTP Site dialog box, click New. In the Add FTP Site

dialog box, enter the name or IP address of your FTP server host, and

then click Next. In the Login Information dialog box, select User.

Modify an

existing site

From the Connect to FTP Site dialog box, select a site.

3. 3. 

4. 4. 

To Do this

Configure an

FTP connection

On the SOCKS tab select Use SOCKS. Click Configure to configure

your SOCKS proxy server.

3.6 Secure FTP Client Connections
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Perform one of the following tasks:

3.6.3 Connect via a Firewall

Connect via a Firewall

Use this procedure if you connect to your FTP or SFTP server through a firewall.

To connect via a firewall

Start the FTP Client.

This opens the Connect to FTP Site dialog box. (If the FTP Client is already running and this

dialog box is not open, go to Connection > Connect .)

Perform one of the following tasks:

To Do this

Configure an

SFTP connection

On the Secure Shell tab click Configure to open the Secure Shell

Settings dialog box. On the General tab, select Use SOCKS Proxy.

Click Configure SOCKS to configure your SOCKS proxy server.

5. 5. 

If you are Do This

Creating a new

site

Click OK to close the Security Properties dialog box and then click

Next. In the FTP User Login dialog box, type your user name on the

FTP server and then click Next. Click Finish.

Modifying an

existing site

Click OK to close the open dialog boxes.

The default port number for SOCKS servers is 1080.

note

1. 1. 

1. 

2. 2. 

To Do This

Create a

new site

From the Connect to FTP Site dialog box, click New. In the Add FTP Site

dialog box, enter the name or IP address of your FTP server host, and

then click Next. In the Login Information dialog box, select User.

3.6.3 Connect via a Firewall
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Click Security .

In the Firewall section, select Use Firewall .

Use Style to select the authentication command sequence used by your firewall. (The style

you select determines which options you can configure in the dialog box.)

Configure the appropriate authentication information for your server.

Perform one of the following tasks:

To Do This

Modify an

existing site

From the Connect to FTP Site dialog box, select a site.

3. 3. 

4. 4. 

5. 5. 

6. 6. 

7. 7. 

If you are Do This

Creating a new

site

Click OK to close the Security Properties dialog box and then click

Next. In the FTP User Login dialog box, type your user name on the

FTP server and then click Next. Click Finish.

3.6.3 Connect via a Firewall
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More information

Firewall Authentication Styles (FTP Client)

Connection Tab (Site Properties Dialog Box)

If you are Do This

Modifying an

existing site

Click OK to close the open dialog boxes.

The Firewall tab is not available for SFTP connections.

The settings in the Firewall tab of the Security Properties dialog box are used for all sites

that you configure to connect via a firewall.

When Use passive mode is enabled (the default), the FTP Client initiates a separate data

connection for directory listings and file transfers. This is required for connections

through some firewalls. If passive mode has been turned off and a directory listing does

not display or you get an error "425 Can't open data connection," you should enable this

setting.

note

• • 

• • 

• • 

• • 

• • 
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Firewall Authentication Styles (FTP Client)

The FTP Client sends different commands for logging onto a firewall and connecting to an FTP

server based on the style of server you specify. During this authentication sequence, the FTP Client

uses information you have configured in the Site Properties dialog box and the Firewall section of

the Security Properties dialog box. If you have not configured all or part of this information, you'll

be prompted for it each time you make a connection.

The following styles are available:

3.6.3 Connect via a Firewall

3.6.3 Connect via a Firewall 20



SITE servername

Use this style if your passthrough server sends a SITE command to connect to the FTP

server. For details, see the SITE Servername Authentication Command Sequence.

username@servername

Use this style if your passthrough server requires server logon information in the format 

username@servername . For details, see the Username@servername Authentication

Command Sequence.

USER-PASS-ACCT

Use this style when you don't need to specify a proxy server because your network

automatically routes connections through the firewall. In this logon sequence both the FTP

site and firewall user names are sent with a single USER command and the firewall

password is sent with the ACCT command. For details, see the USER-PASS-ACCT

Authentication Command Sequence.

Transparent

Use this style when you don't need to specify a proxy server because your network

automatically routes connections through the firewall. In connections made using this style,

a sequence of USER and PASS commands sends logon information for the firewall followed

by the FTP server. For details, see the Transparent Authentication Command Sequence.

Challenge/Response

Use this style if your server requires you to use a hardware token to enter identification

information when you open a connection. When you select this style, you can't preconfigure

password information. During the login process, you'll see a challenge prompt. Use your

token to determine the correct information to enter in response to this prompt. For details,

see the Challenge/Response Authentication Command Sequence.

UserID@FireID@RemoteHost

Use this style if your server requires a login of the style UserID@FireID@RemoteHost. If you

leave the other boxes blank, the FTP Client prompts for information in this order when you

make a connection: Firewall address, Firewall user name, Firewall password, FTP server

address, FTP user name.

FirewallUser@FTPServer

Use this style if your server requires a login of the style FirewallUser@FTPServer. If you

leave the other boxes blank, the FTP Client prompts for information in this order when you

make a connection: Firewall address, Firewall username, Firewall password and FTP

username. For details, see FirewallUser@FTPServer Authentication Command Sequence.

FtpUser@FtpServer FirewallUser

Use this style if your server requires a login of the style FtpUser@FtpServer FirewallUser. If

you leave the other boxes blank, the FTP Client prompts for information in this order when

you make a connection: Firewall address, Firewall username, Firewall password, FTP user

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 
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name FTP password. For details, see FTPUser@FTPServer FirewallUser Authentication

Command Sequence.

More information

Connect via a Firewall

SITE Servername Authentication Command Sequence

The FTP Client uses the following command sequence to make a connection when you have

configured Style to SITE servername in the Firewall section of the Security Properties dialog box.

More information

Connect via a Firewall

Username@servername Authentication Command Sequence

The FTP Client uses one of the following command sequences to make a connection when you

have configured Style to username@servername in the Firewall section of the Security Properties

dialog box.

When Passthrough authentication is selected:

When Passthrough authentication is not selected:

More information

Connect via a Firewall

• 

OPEN <proxy_server>
USER <firewall_username>
PASS <firewall_password>
SITE <FTP_server>
USER <FTP_server_username>
PASS <FTP_server_password>

• 

OPEN <proxy_server>
USER <firewall_username>
PASS <firewall_password>
USER <username>@<FTP_server>
PASS <FTP_server_password>

OPEN <proxy_server>
USER <username>@<FTP_server>
PASS <FTP_server_password>

• 

3.6.3 Connect via a Firewall
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USER-PASS-ACCT Authentication Command Sequence

The FTP Client uses the following command sequence to make a connection when you have

configured Style to USER-PASS-ACCT in the Firewall section of the Security Properties dialog box.

More information

Connect via a Firewall

Transparent Authentication Command Sequence

The FTP Client uses the following command sequence to make a connection when you have

configured Style to Transparent in the Firewall section of the Security Properties dialog box.

More information

Connect via a Firewall

Challenge/Response Authentication Command Sequence

The FTP Client uses the following command sequence to make a connection when you have

configured Style to Challenge/Response in the Firewall tab of the Security Properties dialog box.

More information

Connect via a Firewall

OPEN <FTP_server>
USER <FTP_server_username> <firewall_username>
PASS <FTP_server_password>
ACCT <firewall_password>

• 

OPEN <FTP_server>
USER <firewall_username>
PASS <firewall_password>
USER <FTP_server_username>
PASS <FTP_server_password>

• 

OPEN <FTP_server>
USER <firewall_username>
PASS <challenge_response_from_token>
USER <FTP_server_username>
PASS <FTP_server_password>

• 

3.6.3 Connect via a Firewall
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FirewallUser@FTPServer Authentication Command Sequence

The FTP Client uses the following command sequence to make a connection when you have

configured Style to FirewallUser@FTPServer in the Firewall section of the Security Properties

dialog box.

More information

Connect via a Firewall

FTPUser@FTPServer FirewallUser Authentication Command Sequence

The FTP Client uses the following command sequence to make a connection when you have

configured Style to FTPUser@FTPServer FirewallUser in the Firewall section of the Security

Properties dialog box.

More information

Connect via a Firewall

OPEN <Firewall_server>
USER <Firewall_username>@<FTP_server>
PASS <Firewall_password>
USER <FTP_username>

• 

OPEN <Firewall_server>
USER <FTP_username>@<FTP_server> <Firewall_username>
PASS <FTP_server_password>
ACCT <Firewall_password>

• 

3.6.3 Connect via a Firewall
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3.6.4 Secure Shell Connections (FTP Client)

Secure Shell Connections (FTP Client)

Secure Shell connections require both server and user authentication. The Secure Shell protocol

also provides data encryption. When you configure Secure Shell connections in the FTP Client, you

can use either of the following approaches to ensure that all transferred data is securely encrypted.

Transfer files using the SFTP protocol.

Transfer files using the FTP protocol and use tunneling to forward all communications

through the secure SSH tunnel.

More information

Connect Using Secure Shell (FTP Client)

Forward FTP communications

Connect Using Secure Shell (FTP Client)

The following procedure describes how to use Secure Shell for authentication and encryption in the

FTP Client.

To configure secure Shell connections in the FTP Client

Start the FTP Client.

This opens the Connect to FTP Site dialog box. (If the FTP Client is already running and this

dialog box is not open, go to Connection > Connect .)

Perform one of the following tasks:

• • 

• • 

• • 

• • 

1. 1. 

1. 

2. 2. 

To Do This

Create a new

site

From the Connect to FTP Site dialog box, click New.

In the Add FTP Site dialog box, enter the name or IP address of

your FTP server host, and then click Next.

In the Login Information dialog box, select User.

3.6.4 Secure Shell Connections (FTP Client)
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Click Security .

Select the Secure Shell section.

Select Use Reflection Secure Shell .

Select one of the following options:

(Optional) Specify an SSH config scheme . (If you leave SSH config scheme blank, Reflection

saves any changes you make to an SSH configuration scheme with the same name as the

current host.)

(Optional) Click Configure to open the Secure Shell Settings dialog box. Use this dialog box to

configure user authentication and additional Secure Shell settings.

Perform one of the following tasks:

To Do This

Modify an

existing site

From the Connect to FTP Site dialog box, select a site.

3. 3. 

4. 4. 

5. 5. 

6. 6. 

SFTP Reflection will connect using SFTP (Secure FTP) protocol. SFTP

supports fewer commands than the full FTP protocol.

Tunnel FTP

using port

forwarding

Reflection will secure the port you specify for Local port through the

SSH tunnel. With this configuration you have access to the full range

of FTP commands. All communications are sent through the SSH

tunnel. This includes FTP commands (including user name and

password) and all transmitted data (including directory listings and

the contents of the files you transfer)

7. 7. 

8. 8. 

9. 9. 

If you are Do This

Creating a new site Click OK to close the Security Properties dialog box and then

click Next.

In the FTP User Login dialog box, type your user name on the

FTP server and then click Next.

Click Finish.
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More information

Secure Shell Connections (FTP Client)

If you are Do This

Modifying an

existing site

Click OK to close the open dialog boxes.

Host authentication enables the Secure Shell client to reliably confirm the identity of the

Secure Shell server. This authentication is done using public key authentication. If the

host public key has not previously been installed on the client, the first time you attempt

to connect you see a message indicating that this is an unknown host. This message

includes a fingerprint that identifies the host. To be sure that this is actually your host,

you should contact the host system administrator who can confirm that this is the

correct fingerprint. Until you know that the host is actually your host, you are at risk of a

"man-in-the-middle" attack, in which another server poses as your host.

In most cases you will be able to connect to your host and log in with your password

using the default Secure Shell configuration. Use the Secure Shell Settings dialog box if

you need to configure alternate user authentication methods or to make other changes to

your Secure Shell configuration.

The default Server Type setting for the FTP Client is Auto detect . This setting is not valid

when Secure Shell is configured for SFTP. The FTP Client will automatically modify this

setting from Auto detect to UNIX when you configure Secure Shell to use SFTP. To

change to a different server type, use the General tab of the Site Properties dialog box

after you configure the Secure Shell settings.

note

• • 

• • 

• • 

• 
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Forward FTP communications

FTP command channel and all data channels) using Secure Shell port forwarding. By using port

forwarding, you can make secure connections to FTP servers and have access to the full range of

FTP options and commands, including some that are not available with SFTP connections.

To forward FTP communications

To enable forwarding of the data channel(s), the FTP Client must be configured to

communicate in passive (PASV) mode (the default).

Note
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Start the FTP Client. This opens the Connect to FTP Site dialog box. (If the FTP Client is

already running and this dialog box is not open, go to Connection > Connect .)

Perform one of the following tasks:

Click Security .

Click the Secure Shell tab.

Select Use Reflection Secure Shell .

Select Tunnel FTP using port forwarding

This step is required only if your Secure Shell server is on a different host than the FTP server.

Select FTP host is different than Secure Shell host .

Perform one of the following tasks:

1. 1. 

2. 2. 

To Do This

Create a

new site

From the Connect to FTP Site dialog box, click New. In the Add FTP Site

dialog box, enter the name or IP address of your FTP server host, and

then click Next. In the Login Information dialog box, select User.

Modify an

existing site

From the Connect to FTP Site dialog box, select a site.

3. 3. 

4. 4. 

5. 5. 

6. 6. 

7. 7. 

• 

When you select FTP host is different than Secure Shell host , FTP commands and

data are transmitted securely from your client computer to the Secure Shell server

through a secure tunnel. The commands and data are transmitted in the clear between

the Secure Shell server and the FTP server.

For SSH server address, type your Secure Shell server host name or IP address.

For SSH user name, type your login name on the Secure Shell server.

note

• • 

• • 

• • 

8. 8. 

If you are Do This

Creating a new

site

Select OK to close the Security Properties dialog box and then select

Next. In the FTP User Login dialog box, type your user name on the

FTP server and then select Next. Select Finish.

Modifying an

existing site

Select OK to close the open dialog boxes.
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3.6.5 SSL and TLS Connections (FTP Client)

SSL/TLS Connections (FTP Client)

The Secure Sockets Layer protocol (SSL) and its compatible successor, the Transport Layer

Security protocol (TLS), enable a client and server to establish a secure, encrypted connection over

a public network. When you connect using SSL/TLS, the client authenticates the server before

making a connection, and all data passed between the client and the server is encrypted.

Depending on the server configuration, the server may also authenticate the client.

More Information

Configure SSL/TLS (FTP Client)

Configure SSL/TLS (FTP Client)

TO CONFIGURE A SECURE SSL/TLS CONNECTION IN THE FTP CLIENT

Start the FTP Client.

This opens the Connect to FTP Site dialog box. (If the FTP Client is already running and this

dialog box is not open, go to Connection > Connect .)

Perform one of the following tasks:

You will need to authenticate to both the Secure Shell server and the FTP server.

note

• 

SSL/TLS connections use digital certificates for authentication. Depending on how your

certificate was issued and the way your host is configured, you may need to install a host and/

or personal certificate before you can connect using SSL/TLS.

note

1. 1. 

1. 

2. 2. 

To Do This

Create a

new site

From the Connect to FTP Site dialog box, click New. In the Add FTP Site

dialog box, enter the name or IP address of your FTP server host, and

then click Next. In the Login Information dialog box, select User.
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Select Security .

From the SSL/TLS section of the Security Properties dialog box, select Use SSL/TLS Security .

(Optional) To specify the minimum allowable level of encryption for SSL/TLS connections,

select a level in the Encryption strength list. The connection fails if this level cannot be

provided.

To Do This

Modify an

existing site

From the Connect to FTP Site dialog box, select a site.

3. 3. 

4. 4. 

5. 5. 

Encryption

strength options

Description

Recommended

ciphers

The FTP Client will negotiate with the host system to choose the

strongest encryption level supported by both the host and the

client. This new setting will contain the recommended encryption

level from Open Text, and will change periodically.

NOTE: If you are running in FIPS mode and select Recommended

Ciphers, the FTP Client will negotiate using only FIPS compliant

encryption levels.
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(Optional) Select the PKI section in the left side-menu.

This will open the PKI Configuration settings, from which you can manage the digital

certificates used for authentication.

To use the Reflection Certificate Manager

From the PKI Configuration settings select Reflection Certificate Manager .

In the Reflection Certificate Manager dialog box, select the Trusted Certificate Authorities

tab.

Select Import and browse to select the CA certificate for the server.

Modify default settings as required. (For example, to use only the Reflection Certificate

Manager, you might choose to clear Use System Certificate Store for SSL/TLS

connections . When this option is selected, Reflection FTP Client looks for certificates in

both the Reflection Certificate Manager store and the Windows certificate store.)

Close the Certificate Manager dialog box and click OK to close the other open dialog

boxes.

The imported certificate is saved in the trust_store.p12  file.

After a connection is established, click the Save button on the toolbar and save the

session document.

Perform one of the following tasks:

Encryption

strength options

Description

Custom ciphers If you select Custom ciphers, you will be prompted to select from

a list of available ciphers in the Custom ciphers list view.

NOTE: Session files from previous versions of Reflection that use

default, 168, 128 or 256 bit Encryption Strength will be imported

as Custom Ciphers and maintain the list that was used in prior

versions for those settings options.

6. 6. 

6. 

6. 

a. 1. 

b. 2. 

c. 3. 

d. 4. 

When you customize any of the default PKI settings, the pki_config  file is created.

note

a. 1. 

1. 

1. 

7. 7. 

If you are Do This

Creating a new

site

Click OK to close the Security Properties dialog box and then click

Next. In the FTP User Login dialog box, type your user name on the

FTP server and then click Next. Click Finish.
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If you are Do This

Modifying an

existing site

Click OK to close the open dialog boxes.

Before making an SSL/TLS connection, Reflection authenticates the host system. The

certificate presented by the host for this purpose must be from a trusted certificate

authority. If your computer does not recognize the certificate authority, you will not be

able to make SSL/TLS connections. Depending on how a host certificate was issued, you

may need to install the certificate on your computer.

When you make an SSL/TLS connection, a padlock icon appears indicates that the data

stream is encrypted. A key icon indicates that the command channel (including the

entered password) is encrypted.

note

• • 

• • 
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4. Working with FTP Client Settings Files

4.1 Working with FTP Client Settings Files

The Reflection FTP Client uses settings files to save your configuration. Settings files use an RFW

file extension.

Save your FTP Client Settings

Load Saved FTP Client Settings

Import FTP Client Settings

Import WS_FTP Settings into FTP Client

Save Changes on Exit Dialog Box

Export FTP Settings Dialog Box

More information

FTP Client Settings Files

• • 

• • 

• • 

• • 

• • 

• • 

• 
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4.2 Save your FTP Client Settings

When you start the FTP Client from the Windows Start menu, the client automatically opens a

settings file named Settings.rfw  and any changes you make to your configuration are saved to

this file. If you choose, you can also create additional settings files.

From the File menu, choose Save .

To save your settings to a different settings file

From the File menu, select Save As .

Type a name for the file you are saving.

(Optional) Select Save shortcut on desktop if you want to save a shortcut to your desktop that

will launch the client and open the settings file you are saving.

Click Save .

More information

FTP Client Settings Files

Load Saved FTP Client Settings

Import FTP Client Settings

Create a Shortcut to Load a Settings File

• 

1. 1. 

2. 2. 

3. 3. 

4. 4. 

• • 

• • 

• • 

• • 
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4.3 Load Saved FTP Client Settings

When you start the FTP Client from the Windows Start menu, the client automatically opens a

settings file named Settings.rfw  and any changes you make to your configuration are saved to

this file. If you have created additional settings files, you can use either of these techniques to open

them.

From the File menu, choose Open and then browse to locate your saved file.

To open a settings file using a Windows shortcut

When you save your settings file, create a shortcut to it.

Use this shortcut to launch the client and load that settings file.

More information

Save your FTP Client Settings

Create a Shortcut to Load a Settings File

Import FTP Client Settings

FTP Client Settings Files

• 

1. 1. 

2. 2. 

• • 

• • 

• • 

• • 
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4.4 Import FTP Client Settings

You can export FTP Client settings to XML format using the Export Settings command. This

procedure imports settings from an XML file.

TO IMPORT SETTINGS FROM AN XML FILE

From the File menu, choose Import Settings.

Browse to locate the XML file that contains your site configuration.

Click Open.

You will see a message telling you that the sites were imported successfully.

Click OK.

More information

Save your FTP Client Settings

Load Saved FTP Client Settings

FTP Client Settings Files

Export FTP Settings Dialog Box

1. 1. 

2. 2. 

3. 3. 

3. 

4. 4. 

Settings in the imported file are appended to any currently configured settings, and your

session title is not changed. This is different from opening a saved settings file ( *.rfw ).

When you open a settings file, the settings in that file replace any currently configured

settings in the client, and your session title changes to the name of the open settings file.

note

• • 

• • 

• • 

• • 
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4.5 Import WS_FTP Settings into FTP Client

If you are migrating from WS_FTP, you can import your settings into FTP Client.

Before you begin, locate your wsftp_options.ini  file, typically in the following location:

C:\Users*\AppData\Roaming\IPSwitch\WS_FTP 

C:\Documents and Settings*\Application Data\Ipswitch\WS_FTP

TO IMPORT WS_FTP SETTINGS

From the FTP Client File menu, choose Import Settings.

From the Files of type drop-down list, select "Import WS_FTP (wsftp_options.ini)."

Browse to locate your wsftp_options.ini  file, click Open, then click OK.

You should see a message saying that your settings were imported successfully.

Click File > Save to save the imported settings.

More information

Save your FTP Client Settings

4.6 Save Changes on Exit Dialog Box

Reflection FTP Client displays the Save Changes on Exit dialog box if you have made any changes

to your settings in the current session. The options are:

1. 1. 

2. 2. 

3. 3. 

4. 4. 

5. 5. 

• 

Save Saves all changes you have made to settings.

Discard Exits without saving any changes you have made during the current

session.

4.5 Import WS_FTP Settings into FTP Client
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4.7 Export FTP Settings Dialog Box

Getting there

From the FTP Client File menu, choose Export Settings .

The options are:

Cancel Cancels the exit command and returns you to the Reflection session

without saving any changes.

• 

Sites Site-specific settings are configured using the Site > Properties dialog

box or the Directory Definition Wizard. All settings are exported for each

site with the exception of user name and password, which are included

only when User Settings is also selected.

Select which of your currently configured sites are included in the

exported settings file. Select a site and click Remove if you don't want

the site included in the exported file.

Application

Settings

Application settings affect the behavior of the FTP Client and are

independent of both site and user. The following information is included: 

Options dialog box, General tab - Default local home folder

Options dialog box, File Types tab - All features

Options dialog box, Preferences tab - All features

User

Settings

The following information is included:

Site Properties dialog box - User and Password

Options dialog box, General tab - Anonymous password

Custom rules created using the Directory Definition Wizard.

• 

• 

• 

• 

• 

• 
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More information

Change Global Settings for the FTP Client

Change Settings for an FTP or SFTP Site

Run the Directory Definition Wizard

File Name Type a path and filename for the exported settings file. If you change the

default filename, you must include a file extension if you wish to use one.

• • 

• • 

• • 
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5. Configuring Site and Global Properties

5.1 Configuring Site and Global Properties

Change Global Settings for the FTP Client

Change Settings for an FTP or SFTP Site

• • 

• • 
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5.2 Change Global Settings for the FTP Client

5.2.1 Change Global Settings for the FTP Client

Global settings allow you to configure the default behavior for connections to all servers.

TO CONFIGURE GLOBAL SETTINGS

From the Tools menu, choose Options.

More information

General Tab (Options Dialog Box)

File Types Tab (Options Dialog Box)

Preferences Tab (Options Dialog Box)

File Attributes Tab (Options Dialog Box)

Directory Attributes Tab (Options Dialog Box)

Change Settings for an FTP or SFTP Site

5.2.2 General Tab (Options Dialog Box)

From the FTP Client Tools menu, choose Options .

The options are:

1. 

• • 

• • 

• • 

• • 

• • 

• • 

Getting there

Anonymous

Password

Type the default password to use for anonymous connections to FTP

sites.

This feature is not available for SFTP connections.

5.2 Change Global Settings for the FTP Client
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More information

Directories Tab (Site Properties Dialog Box)

5.2.3 File Types Tab (Options Dialog Box)

From the FTP Client Tools menu, choose Options.

Use this tab to configure Smart file transfer. When Smart file transfer is enabled, any file of a

defined file type is transferred using the transfer method specified for that file type. To enable

Smart file transfer, go to Tools > Transfer Method > Smart.

The options are:

Default local

home folder

Specify the folder that displays automatically when you start the client

and receives files transferred from the server. Your Windows user folder

is the default.

Default local home folder is a global default. It is ignored if you specify

a site-specific value for Home folder on the Directories tab in the Site > 

Properties dialog box.

You can specify a local home folder using UNC paths such as:

\\<computername>\<sharename>\<pathname>

• 

Getting there

Smart file transfer

types

Lists all file types that have been assigned a transfer method.

New Open the Add Smart File Type dialog box.

Delete Remove the currently selected file type from the list.

Change Edit the currently selected file type.

5.2.3 File Types Tab (Options Dialog Box)
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More information

Set the Transfer File Type (Transfer Method)

Add Smart File Type Dialog Box

5.2.4 Preferences Tab (Options Dialog Box)

From the FTP Client Tools menu, choose Options .

The options are:

Transfer method

for undefined file

types

Specify a default for files types that have no associated transfer

method.

If Ask User is specified, you are prompted to specify a transfer

method when you transfer a file with that extension. At that time

you can select a specific transfer method or choose Always ask

user.

• • 

• • 

Getting there

When the FTP

Client exits

Select how the client handles configuration changes. If you select 

Save configuration automatically, changes are saved to the current

settings file.

Confirm file delete Select whether the client prompts you for confirmation before

deleting a file or folder.

Hide progress

window

Suppress the connection progress, transfer progress, and error

notification dialog boxes.

Do not use

animation

By default Reflection uses animation during certain actions, for

example a waving flashlight appears while you are waiting for a

directory listing. Turning off the use of animation may fix some

problems that cause Reflection to become unresponsive.

5.2.4 Preferences Tab (Options Dialog Box)
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More information

FTP Client Settings Files

Working with FTP Client Settings Files

Transfer Files between Two Remote Sites

5.2.5 File Attributes Tab (Options Dialog Box)

From the FTP Client Tools menu, choose Options .

Use this tab to configure default attributes for file transfers.

Force site-to-site

transfers through

local machine

Force all site-to-site transfers to copy files first to the local

computer then to the destination server. Use this for FTP servers

that don't support direct site-to-site transfers.

NOTE: If there is a secure connection to either server, or the

transfer type is not Binary, the client always transfers files this way,

regardless of the value of this setting.

• • 

• • 

• • 

Getting there

Set default file

attributes on

uploads

Set default permissions for files copied to the server. When Set

default file attributes on uploads is selected, you can specify

permissions using either the Permission Mode box, or using the 

Owner, Group, and Public check boxes.

NOTE:

To specify non-default permissions during a file transfer, you can

configure Site Properties > Transfer > Show upload options

before transfer.

When this setting is enabled, the File Upload Options dialog box is

displayed before you transfer files to the server.

When Set default file attributes on uploads is selected, the client

sends a chmod command to the server to set the permissions

you have specified. If your server does not support this

command, you will receive a server error message that the chmod

command is unrecognized.

• 

• 
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More information

Set File and Directory Permissions

Change the Filename when Downloading

Change the Filename when Uploading

Set Time and Date of Downloaded Files

5.2.6 Directory Attributes Tab (Options Dialog Box)

From the FTP Client Tools menu, choose Options.

Use this tab to set default permissions for newly created directories.

Set default file

attributes on

downloads

Set default attributes for files copied to the client. When Set default

file attributes on downloads is selected, you can specify attributes

using the Read-only and/or Hidden check boxes.

NOTE: To specify non-default permissions during a file transfer, you

can configure Site Properties > Transfer > Show download options

before transfer. When this setting is enabled, the File Download

Options dialog box is displayed before you transfer files to the client.

• • 

• • 

• • 

• • 

Getting there

Option Description

Set default directory

attributes on creation

Enable this option to set directory permissions when a

new directory is created on the server.

Permission Mode Type a three digit number that is a valid value for the host.

NOTE: valid values have digits from 0 to 7.

5.2.6 Directory Attributes Tab (Options Dialog Box)
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More information

Set File and Directory Permissions

Option Description

Owner, Group, and Public Select options to allow each user type permission to read,

write, or execute.

• 

5.2.6 Directory Attributes Tab (Options Dialog Box)
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5.3 Change Settings for an FTP or SFTP Site

5.3.1 Change Settings for an FTP or SFTP Site

Use the Site Properties dialog box to configure how the client behaves when connecting and

interacting with a particular remote site.

TO MODIFY THE SETTINGS FOR A PARTICULAR SITE

Start the FTP Client.

This opens the Connect to FTP Site dialog box. (If the FTP Client is already running and

this dialog box is not open, go to Connection > Connect .)

From the Connect to FTP Site dialog box, select a site.

Click the Properties button.

More information

General Tab (Site Properties Dialog Box)

Connection Tab (Site Properties Dialog Box)

Directories Tab (Site Properties Dialog Box)

Translation Tab (Site Properties Dialog Box)

Transfer Tab (Site Properties Dialog Box)

Information Tab (Site Properties Dialog Box)

Change Global Settings for the FTP Client

Getting there

1. 1. 

1. 

2. 2. 

3. 3. 

If you are already connected to a site, from the Connection menu, choose Site

Properties .

Some changes you make using the Site Properties dialog box when connected will not

take effect until the next time you connect to the site.

note

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 
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5.3.2 General Tab (Site Properties Dialog Box)

Start the FTP Client.

This opens the Connect to FTP Site dialog box. (If the FTP Client is already running and

this dialog box is not open, go to Connection > Connect.)

From the Connect to FTP Site dialog box, select a site.

Click the Properties button.

Use this tab to provide connection information for the specified site.

The options are:

Getting there

1. 1. 

1. 

2. 2. 

3. 3. 

If you are already connected to a site, from the Connection menu, choose Site

Properties .

Some changes you make using the Site Properties dialog box when connected will not

take effect until the next time you connect to the site.

note

• • 

• • 

FTP

address

Type the FTP or SFTP server to log on to. This can be a domain name, a URL,

or an IP address.

5.3.2 General Tab (Site Properties Dialog Box)
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Log on as

Server

type

In most cases, FTP Client will correctly identify your server when this value is

set to Auto detect. If FTP Client is not successfully identifying the type of

server you are connecting to, select it from this list. 

Auto detect is not available for SFTP sessions. The default for these

sessions is UNIX.

Anonymous Log on to the FTP server as a guest, with the user name anonymous .

(Anonymous logons are not allowed for SFTP connections.) 

If you log on to this server anonymously, the Password box is

automatically filled in with the anonymous password specified on the 

General tab in the Options dialog box. If this FTP site expects a

different password for anonymous users, type the site-specific

password here.

User Log on to the specified server using a registered user name.

User name Enter your user name as it is registered on the FTP server.

Save password

as obfuscated

test

Save your password as obfuscated text in your settings file and use it

to log on to this server.

Password Enter the password the FTP server associates with the user name

registered on the FTP server.

Use Windows

Credentials

Use your Windows credentials instead of your FTP user name and

password when performing a data transfer. This option can be used

only with IBM System i (AS/400) and IBM AS/400 (Format 0) server

types.

5.3.2 General Tab (Site Properties Dialog Box)
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Security Configure a secure connection to the specified server.

5.3.2 General Tab (Site Properties Dialog Box)
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5.3.3 Connection Tab (Site Properties Dialog Box)

Start the FTP Client.

This opens the Connect to FTP Site dialog box. (If the FTP Client is already running and

this dialog box is not open, go to Connection > Connect .)

From the Connect to FTP Site dialog box, select a site.

Click the Properties button.

Use this tab to configure settings for maintaining connections and to set timeout intervals.

CONNECTION OPTIONS

Getting there

1. 1. 

1. 

2. 2. 

3. 3. 

If you are already connected to a site, from the Connection menu, choose Site > 

Properties .

Some changes you make using the Site Properties dialog box when connected will not

take effect until the next time you connect to the site.

note

• • 

• • 

For SFTP connections, the only setting available from this tab is Use IPV6 .

note

Use passive

mode

When selected, the client sends a PASV command to communicate with

the server in passive mode (sometimes called PASV mode). This initiates

a separate data connection for directory listings and file transfers. 

Use passive mode to minimize connection problems with firewalls. 

If passive mode has been turned off and a directory listing does not

display or you get an error "425 Can't open data connection," you should

enable this setting. 

IPV6 connections use EPSV.

5.3.3 Connection Tab (Site Properties Dialog Box)
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TIMEOUTS IN SECONDS

OTHER SETTINGS

Send keep

alive every 

<n>

seconds

Most FTP servers have an "idle time" value that specifies how long a

user's FTP session can last when no activity is detected. When the user

exceeds the time limit, the server connection is closed. This setting

allows you to direct the Client to send a NOOP command to the server at

timed intervals to prevent the server from closing the connection due to

inactivity. When selected, specify the number of seconds to wait between

transmissions of NOOP commands.

TCP port Use the TCP port box to specify a non-standard TCP service port number

or socket for FTP. The default value 21 is the standard service port for

FTP.

Account If your server requires an account name for file access, type it here. For

case-sensitive servers, be sure to use the appropriate case. 

When a connection is opened, if Account is filled in, the client

automatically sends the account name to the server as the last logon

listitem.

Connect Select the maximum number of seconds to continue trying to establish an

FTP server connection. Entering 0 (zero) in this box prevents the FTP Client

from ever timing out on a connection attempt.

Session Select the maximum number of seconds to wait for data packets being

transferred to or from the host. If nothing is received within the period

specified, a timeout error displays and the transfer is aborted; in this case, try

the operation again. If you receive repeated timeout errors, increase the

timeout value. Entering 0 (zero) in this box prevents the FTP Client from ever

timing out when waiting for a response.

Use

IPV6

Select whether connections to the host use IPV6 (Internet Protocol version 6)

or the older IPv4 protocol. By default, the client attempts to connect using

IPv6, and uses IPv4 when IPv6 is not available. You may need to change this

value to "Never" if you are having problems connecting to hosts on an IPv4

network from a client computer with IPv6 enabled.
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Initial

umask

Use this setting to specify an initial umask value to send to the server upon

connection. You can use umask to modify the default permissions attributes

set on newly created files. When you specify a umask, the client sends the

following to the FTP server when you login, where nnnn is your specified

umask value. 

SITE umask nnnn

To find out if umask is a supported SITE command for your FTP server, enter

this command at the FTP command line: 

QUOTE help site

NOTE:

The umask set by the FTP client cannot be less restrictive than user

permissions set on the server.

This option is not available if you have configured global upload attributes

using Tools > Options > Attributes > Set default attributes on uploads.

This option is not available for SFTP connections.

• 

• 

• 
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5.3.4 Directories Tab (Site Properties Dialog Box)

Start the FTP Client.

This opens the Connect to FTP Site dialog box. (If the FTP Client is already running and

this dialog box is not open, go to Connection > Connect.)

From the Connect to FTP Site dialog box, select a site.

Click the Properties button.

Use this tab to specify how your directory listings are displayed. The options are:

SERVER

Getting there

1. 1. 

1. 

2. 2. 

3. 3. 

If you are already connected to a site, from the Connection menu, choose Site

Properties.

Some changes you make using the Site > Properties dialog box when connected will not

take effect until the next time you connect to the site.

note

• • 

• • 

Home directory Select the server directory the FTP Client should display after a

connection is made.

Show directory

upon connection

Select whether a list of the files and folders in the working server

directory is displayed in the right pane each time you open a

connection to this site. If you choose not to show server directories

and you want to change to a different server directory, use the Go To

command on the Tools menu or use the CD command at the FTP

command line.

Refresh

directory

automatically

Select whether the server directory listing shown in the right pane is

updated when you execute a CD command, or perform any operation

that adds or deletes files or directories on the server.

Try to convert

dates to local

system format

Select whether dates display in the format specified by the regional

settings in Windows Control Panel. Leave this check box cleared if

you want dates to display in the date format used on the server.
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Resolve links Select how directory listings are created when you are connected to a

server that supports symbolic links. When this box is checked, the

server pane correctly uses folders to display symbolic links that

identify directories. Clear this box if you don't need this feature and

you want to improve response time for new or refreshed file listings.

Cache directory

listing

Select whether directory listings are cached on your local PC. Using

cached directory listings speeds up the server pane display as you

navigate through your server directories, but will not reflect changes

you have made to your server files. When this box is cleared, file

listings are updated from the server each time you change the

display. 

NOTE: Using the Refresh command (F5) always shows any changes

you have made on the server even if you are using cached file

listings.

Display file

names only

Select whether directory listings include filenames only. You can use

this setting as a troubleshooting tool if the client is having difficulty

displaying directory listings for your host. When this check box is

cleared, file listings are created using the FTP LIST command; when it

is selected, file listings use NLST. 

This setting does not apply to SFTP connections.

Don't send PWD

command

When this option is selected, the FTP Client does not send a PWD

command when you are connected to the server. Enabling this setting

may fix connection problems encountered with some hosts. When it

is enabled, the current server directory path won't be displayed in the

server's title bar, and the Go to a different Folder list box (located on

the left side of the toolbar), will not display host directory

information. You will see your local PC directories even when the

server pane is selected. 

NOTE: Press F7 to open the command window before you try

connecting to your server. If the server returns an error after

Reflection sends the PWD command, try enabling this setting. 

This setting does not apply to SFTP connections.

File View Filter Type a default file view filter for the server using wildcard characters

that are recognized by the server. For more information, see the Filter

the Server File Listing topic. This feature is not available for SFTP

connections.
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LIST command

parameters

Specify the command parameters the FTP Client uses when it sends

an FTP LIST command to the server. The appropriate parameters

depend on the type of server you are connecting to. Changing this

value may help troubleshoot some problems. Use caution when

modifying LIST command parameters for use with the MDEL

command. 

On some systems the list can be set to recursively list files in

subfolders. 

This feature is not available for SFTP connections.
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LOCAL

More information

Filter the Server File Listing

Show attributes

before creating

directory

Select this option to see a dialog box that enables you to set directory

permissions whenever you create a new directory on the server.

Home

folder

Type the path to a home (default) folder for the FTP Client. When a connection

to the site is opened, the local working folder is set automatically to the

specified home path and that location will receive any server files you transfer

using the Download command. 

The global Default local home folder setting is ignored for this site.

• 
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5.3.5 Translation Tab (Site Properties Dialog Box)

Start the FTP Client.

This opens the Connect to FTP Site dialog box. (If the FTP Client is already running and

this dialog box is not open, go to Connection > Connect .)

From the Connect to FTP Site dialog box, select a site.

Click the Properties button.

Use this tab to control conversion of formatting characters in ASCII data transferred to the client or

to the server.

TO SERVER

Getting there

1. 1. 

1. 

2. 2. 

3. 3. 

If you are already connected to a site, from the Connection menu, choose Site

Properties .

Some changes you make using the Site Properties dialog box when connected will not

take effect until the next time you connect to the site.

note

• • 

• • 

Translation tab settings are not available for SFTP connections.

important

Change

tabs to

spaces

Spaces replace tab characters in uploaded files.

Spaces per

tab

Define the size of the tab stops used if you change spaces to tabs or tabs

to spaces.
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FROM SERVER

Read CTRL-

Z as end of

file

When selected, file transfer uses a Ctrl-Z ( ^Z ) character as the end-of-file

marker, and strips it from the file being sent. Otherwise, the character

count in the file directory is used to determine the file length. The FTP

Client never sends Ctrl-Z if it is the last character in an ASCII file.

Change spaces

to tabs

Select to have tab characters replace consecutive spaces in

downloaded files. Use Spaces per tab (under To server) to specify

how many spaces equal one tab.

Write Ctrl-Z at

end of file

On the local computer, ASCII text files normally end with a Ctrl-Z ( ^Z )

character. If you want a ^Z  character added to the file when it is

received from the server, keep this option selected. Some Windows

applications require this marker.

Delete trailing

spaces

Select to save local disk space. Some host text files use fixed-length

records to delimit lines; they pad the end of each record with blanks.

Most PC text processing programs use a carriage return and linefeed

sequence to delimit lines and paragraphs, and thus do not need

blanks preceding a delimiter.
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ADDITIONAL OPTIONS

More information

Character Sets Dialog Box

A six digit date

on the server

represents

Select how six digit dates on the server are interpreted. MM

represents the month, DD the day, and YY the year.

Character Sets

button

Open the Character Sets dialog box to configure translation between

the server character set and either the Windows or DOS character set.

• 
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5.3.6 Transfer Tab (Site Properties Dialog Box)

Start the FTP Client.

This opens the Connect to FTP Site dialog box. (If the FTP Client is already running and

this dialog box is not open, go to Connection > Connect .)

From the Connect to FTP Site dialog box, select a site.

Click the Properties button.

Use this tab to specify how filenames and dates are handled during file transfers to and from the

server. The options are:

DOWNLOAD FROM SERVER OPTIONS

Getting there

1. 1. 

1. 

2. 2. 

3. 3. 

If you are already connected to a site, from the Connection menu, choose Site

Properties .

Some changes you make using the Site > Properties dialog box when connected will not

take effect until the next time you connect to the site.

note

• • 

• • 

Preserve

server file date

Retain the original date stamps associated with downloaded files. If

you want files transferred from the server to be date stamped with the

time and date when they were transferred, keep this check box

cleared. 

NOTE: Server file dates will not be preserved if the Display file names

only setting on the Directories tab has been enabled.

Server file dates are not preserved when files are dragged to the

Windows desktop or Windows Explorer folder. Drag files to the local

pane of the FTP Client to preserve file dates.

To retain original server dates in transfers done by a script, you can

either load your site settings when you launch the script or add the

following line to the beginning of the script: PRESERVE-FILE-DATE yes
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UPLOAD TO SERVER OPTIONS

Create

Windows file

names in 8.3

format

Select to receive host files in the DOS 8.3 filename format. 

For example, a file with the name Longfilename.Document  will be

converted automatically to Longfile.doc  when transferred to your

PC. 

NOTE: During wildcard transfers with this check box selected, if two

long filenames translate to the same DOS 8.3 format name, the

second file transferred will overwrite the first when If File Exists is set

to Overwrite.To prevent this, change the If File Exists setting to 

Unique.

Try to resume

partial binary

downloads

Select to have the FTP Client try to resume downloading the

untransferred portion of files after an interruption. 

For more information, see the Resume an Incomplete Server File

Download topic. 

This feature is not available for SFTP connections.

Show

download

options before

transfer

Select this option if you want to be queried for the transfer method (for

example, ASCII or binary) and file properties (read-only or hidden)

before downloading a new file from the server.

Send SITE

command

before transfer

Type a SITE command to be executed before a file is downloaded. To

find out what SITE commands are supported by the current FTP server,

enter this command at the FTP command line: QUOTE help site  This

feature is not available for SFTP connections.

Remove file

name extension

Remove the filename extension from files transferred to the host. If

an uploaded file's name contains one or more dots, the final dot and

any subsequent characters are removed from the filename.

Prepend these

characters to the

file name

Add the specified characters before the filename for files copied to

the host. For example, you can use this feature to specify a member

name for transfers to an IBM host. If you are connected to an HP

POSIX host, the client automatically sets this value to a period

followed by a slash ( ./ ).
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Server file name

limit

Set a limit to the number of characters in the filename for files

transferred to the host. Filenames beyond this limit are truncated.

Set case of long

file names

Select how case is handled in when the transferred filename does not

conform to the DOS 8.3 file naming convention.

Set case of 8.3

file names

Select how case is handled when the transferred filename does

conform to the DOS 8.3 file naming convention.

Compute space

on MVS

By default, the FTP Client computes and preallocates the number of

tracks on MVS system based on the local file size. Clear this option

to disable this feature. This setting applies to uploads to MVS hosts

only.

Send SITE

command

before transfer

Type a SITE command to be executed before a file is uploaded. To

find out what SITE commands are supported by the current FTP

server, enter this command at the FTP command line: 

QUOTE help site

This feature is not available for SFTP connections.
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More information

Handle Existing Files (Transfer Mode)

Resume an Incomplete Server File Download

Directories Tab (Site Properties Dialog Box)

Set Time and Date of Downloaded Files

5.3.7 Information Tab (Site Properties Dialog Box)

Start the FTP Client.

This opens the Connect to FTP Site dialog box. (If the FTP Client is already running and

this dialog box is not open, go to Connection > Connect .)

From the Connect to FTP Site dialog box, select a site.

Click the Properties button.

This tab shows information about the current FTP Client connection. It is available only when you

are connected to a site.

Click Reset to reset the transfer time and transfer rate data to zero.

Show upload

options before

transfer

Select this option if you want to be queried for the transfer method

(for example, ASCII or binary) and file permission attributes before

uploading a new file to the server.

• • 

• • 

• • 

• • 

Getting there

1. 1. 

1. 

2. 2. 

3. 3. 

If you are already connected to a site, from the Connection menu, choose Site

Properties .

Some changes you make using the Site > Properties dialog box when connected will not

take effect until the next time you connect to the site.

note

• • 

• • 
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6. Transferring Files

6.1 Transferring Files

Transfer Files with FTP Client

Set the Transfer File Type (Transfer Method)

Add a Smart File Transfer Type

Specify a Default Smart File Transfer Type

Handle Existing Files (Transfer Mode)

Set Time and Date of Downloaded Files

Transfer Files between Two Remote Sites

Change the Filename when Downloading

Change the Filename when Uploading

Resume an Incomplete Server File Download

Character Sets Dialog Box

Add Smart File Type Dialog Box

Smart Transfer File Type Dialog Box

Confirm File Replace Dialog Box

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 
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6.2 Transfer Files with FTP Client

You can transfer files in the FTP Client with a simple drag and drop operation. You can drag

individual files, multiple files, and entire folders.

To transfer files with FTP Client

Connect to an FTP site.

Specify a transfer method (Tools > Transfer Method).

Set the preference for handling existing files. (Tools > If File Exists).

Browse to locate the files or folders you want to transfer and the destination location.

Select the files or folders you want to transfer and drag them from the source location to your

desired destination.

More information

Connect to a Site

Set the Transfer File Type (Transfer Method)

Handle Existing Files (Transfer Mode)

View the Local PC Files

View the Server Files

Use the FTP Command Line

1. 1. 

2. 2. 

3. 3. 

Additional file transfer settings are available from the Site Properties dialog box. You can use

these site-specific properties to configure file transfer.

note

4. 4. 

5. 5. 

If you prefer to transfer files using FTP (or SFTP) file transfer commands, you can initiate

transfers directly from the FTP command line.

note

• • 

• • 

• • 

• • 

• • 

• • 
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6.3 Set the Transfer File Type (Transfer Method)

Use Transfer Method to specify the file type for transfers. The currently active transfer method is

indicated on the status bar, on the toolbar, and in the Transfer Method menu.

From the Tools menu, point to Transfer

Method and then click the transfer method you want to use.

The options are:

ASCII

Select ASCII for text files. ASCII data is transferred according to settings in the Character

Sets dialog box.

Binary

Use the Binary transfer method to transfer binary files, such as .exe  files and .doc  files.

Binary files are not converted or translated during the transfer.

Tenex (Local 8)

Select Tenex (also known as "Local 8") if you're moving files to or from a server that uses a

non-8-bit byte, such as the DECsystem-20.

Smart

Select Smart if you want the FTP Client to determine what transfer method to use ( ASCII,

Binary , Tenex, or Ask User) based on the source file extension. To configure this, use Tools

> Options > File Types.

More information

Character Sets Dialog Box

Add a Smart File Transfer Type

Specify a Default Smart File Transfer Type

Add Smart File Type Dialog Box

• 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 
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6.4 Add a Smart File Transfer Type

Use the Smart transfer method if you want the FTP Client to determine which transfer method to

use ( ASCII, Binary , Tenex, or Ask User) based on the source file extension. When performing a

Smart file transfer, the client refers to the list of Smart file types to determine what transfer method

to use for the current file. You can add file types to the default Smart file types list, or change the

file transfer method used for existing file types. For example, you might specify that files with

names ending in .doc  use the Binary transfer method.

TO ADD A NEW SMART FILE TRANSFER TYPE

From the Tools menu, choose Options .

Click the File Types tab.

Click New .

Use the following settings from the Add Smart File Type dialog box to define a new file type:

1. 1. 

2. 2. 

3. 3. 

4. 4. 

For this

setting

Do this

File type Type the file type extension that identifies this file type, or select a file

type from the list.
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More information

Set the Transfer File Type (Transfer Method)

Specify a Default Smart File Transfer Type

Add Smart File Type Dialog Box

For this

setting

Do this

Transfer

method

Select a transfer method for files of this type. This setting determines

how files of this type are saved, and any data manipulation that should

be performed during the transfer.

To define a transfer method for files that don't have an extension, choose in the File

type box, and then select a transfer method.

If a file extension might identify files of several types, you can specify Ask User as the

transfer method for that extension.

note

• • 

• • 

• • 

• • 

• • 
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6.5 Specify a Default Smart File Transfer Type

The default Smart transfer type applies to any file types that have not been defined previously.

TO SPECIFY A DEFAULT SMART FILE TRANSFER TYPE

From the Tools menu, choose Options.

Click the File Types tab.

Under Transfer method for undefined file types , select a transfer type.

More information

Set the Transfer File Type (Transfer Method)

Add a Smart File Transfer Type

6.6 Handle Existing Files (Transfer Mode)

You can set a transfer mode to specify how the FTP Client should handle transfer when a file with

the same name already exists in the target location. The current transfer mode is indicated on the

status bar next to the transfer method.

From the Tools menu, point to If File Exists and then click the transfer mode you want to use.

1. 1. 

2. 2. 

3. 3. 

If you have files that have the same file extension, but require a different transfer method, do

not set a default type. Set Transfer method for undefined file types to Ask User . Or, set the

file transfer method you want to use prior to transferring the file(s).

note

• • 

• • 

• 

Append Append the downloaded file to the destination file. This option is only

available for transfers from the host.

Ask User Open the Confirm File Replace dialog box to allow the user to decide what to

do.

Cancel The file transfer is canceled when a file with the specified name already

exists. If the file is part of a wildcard set (files being transferred using

wildcards or a string of filenames), no other files are transferred to the PC

after a duplicate is found.

Overwrite Overwrite the destination file.
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Skip Do not transfer this file. If additional files are specified for this transfer

operation, continue with the next file.

Update Overwrite the destination file only if the file being transferred is newer than

the destination file.

6.6 Handle Existing Files (Transfer Mode)
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More information

Confirm File Replace Dialog Box

Transfer Files with FTP Client

Commands for Error Handling

6.7 Set Time and Date of Downloaded Files

Open the Site Properties dialog box and then click the Transfer tab.

Select Preserve server file date if you want all files transferred from the server to retain the

original time and date. Clear this box if you want files transferred from the server to be

stamped with the time and date when they were transferred.

More information

Change Settings for an FTP or SFTP Site

Transfer Tab (Site Properties Dialog Box)

Unique Automatically create a unique name for the destination file. The names of

any files that are renamed during the transfer operation are shown in the

FTP command window.

In some circumstances, this setting is ignored. The value you specify using the If File Exists

command applies only to transfers within the FTP Client. If you use drag-and-drop to transfer a

file from a client display pane to your desktop or an open Windows Explorer window, Windows

will always display a Confirm File Replace dialog box whenever a file exists, regardless of the

FTP Client configuration. To take advantage of the currently configured option, always use

Reflection panes for drag-and-drop transfers.

note

• • 

• • 

• • 

1. 1. 

2. 2. 

• • 

• • 
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6.8 Transfer Files between Two Remote Sites

You can use the FTP Client to drag files between two remote sites.

To transfer files between two remote sites

Connect to your first server site.

From the Connection menu, click Connect to a second site .

The server pane will display files and folders for both sites.

Use the drag-and-drop method to transfer files directly from one server to another.

More information

Transfer Files with FTP Client

Connect to a Site

Preferences Tab (Options Dialog Box)

1. 1. 

2. 2. 

2. 

3. 3. 

If the transfer type is Binary and both connections are configured without security

features in place (such as use of a proxy server, Secure Shell, port forwarding, or sftp)

the data is transferred directly over the data channel between the two sites.

If there is a secure connection to either server, or the transfer type is not Binary , the

client downloads the file to a temporary location on your PC and then uploads it to the

other site. The temporary file is deleted after the transfer is complete.

note

• • 

• • 

• • 

• • 

• • 
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6.9 Change the Filename when Downloading

The Download As command is available when you right-click on a file in the server pane. You may

prefer this command over drag-and-drop file transfer when you want to transfer a server file to your

PC and use a different file name on the PC.

To download a file using a different name

Right-click on the file you want to download, and then choose Download As .

From the Download As dialog box, in the Download As box, type the name you want to use for

the file on the PC.

Select OK to complete the transfer.

Also, wildcard characters are supported. You can download multiple files at once, changing all of

the filenames. For example, you could change all of the .htm  files in a directory to .html  when

you download them to your PC.

To download multiple files using a different name

Right-click on one of the files you want to download, and then choose Download As .

From the Download As dialog box, in the Server file(s) box, replace one or more parts of the

filename with wildcards, leaving enough to identify which files you want.

For example, *.htm . or *_info_??.text

From the Download As dialog box, in the Download As box, make the same wildcard

replacements, and change the part of the filename you want to make different on your PC.

For example, *.html . or *_info_??.txt .

Select OK to complete the transfer.

More information

View the Server Files

Transfer Files with FTP Client

1. 1. 

2. 2. 

3. 3. 

1. 1. 

2. 2. 

2. 

3. 3. 

3. 

4. 4. 

• • 

• • 
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6.10 Change the Filename when Uploading

The Upload to Server command is available when you right-click on a file in the left pane of the FTP

Client. You may prefer this command over drag-and-drop file transfer when you want to transfer a

local file to the server and use a different file name on the server.

To upload a file using a different name

Right-click on the file you want to upload, and then select Upload As.

From the Upload As dialog box, in the Upload As box, type the name you want to use for the

file on the server.

If you are connected to two remote sites, both site names will appear in the Upload As dialog

box. Select the site to which you want the file transferred.

Select OK to complete the transfer.

Also, wildcard characters are supported. You can upload multiple files at once, changing all of the

filenames. For example, you could change all of the .htm  files in a directory to .html  when you

upload them to the server.

To upload multiple files using a different name

Right-click on one of the files you want to upload, and then select Upload As.

From the Upload As dialog box, in the Source file(s) box, replace one or more parts of the

filename with wildcards, leaving enough to identify which files you want.

For example, *.htm . or *_info_??.text

From the Upload As dialog box, in the Upload As box, make the same wildcard replacements,

and change the part of the filename you want to make different on your server.

For example, *.html . or *_info_??.txt .

Select OK to complete the transfer.

More information

View the Local PC Files

Transfer Files with FTP Client

1. 1. 

2. 2. 

3. 3. 

4. 4. 

1. 1. 

2. 2. 

2. 

3. 3. 

3. 

4. 4. 

• • 

• • 
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6.11 Resume an Incomplete Server File Download

Sometimes when downloading a server file to your PC, the transfer does not complete successfully,

perhaps due to a loss of the network connection on a "noisy" or low-speed link.

When a file transfer fails to complete, the auto resume feature lets you resume the incomplete file

transfer operation. The auto resume feature works only under these circumstances:

The FTP server must support the REST command

To auto resume a file transfer, the FTP Client sends a REST command (restart) to the server.

If the server does not support the REST command, the file transfer will start from the

beginning of the file. For each site, after the first auto resume operation is attempted, the

FTP Client will remember the result. If the server does not support the REST command, the

Client won't attempt to perform an auto resume for any file transferred from that server.

To determine if a particular server supports this feature, enter the following on the

command line:

If rest  is identified as a restart command, your server supports the feature

File transfer method (or type) must be Binary

Auto resume compares the size of the source file to the size of the incomplete target file to

determine at what point in the source file it should resume the transfer. An ASCII file transfer

creates a file on the local machine that may differ in size from the source file.

File transfer mode cannot be Append

When you transfer a file using the Append mode, the FTP Client can't use the existing target

file size to determine the restarting point to use in the source file.

To resume an incomplete download

This feature is not available for SFTP connections.

note

• • 

quote help rest

• • 

• • 
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If necessary, reconnect to the server where the source file resides.

Confirm the three circumstances above.

From the Transfer tab of the Site Properties dialog box, select Try to resume partial binary

downloads.

Restart the server file download. For example, select the server file that failed to transfer and

drag it again to the destination on your PC.

The client detects that a prior incomplete file transfer operation occurred for that file, and

gives you the option to resume the incomplete transmission at the interruption point, instead

of beginning a new file transfer of the entire file.

Click Resume.

More information

Set the Transfer File Type (Transfer Method)

Handle Existing Files (Transfer Mode)

Transfer Tab (Site Properties Dialog Box)

1. 1. 

2. 2. 

3. 3. 

4. 4. 

5. 5. 

6. 6. 

• • 

• • 

• • 
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6.12 Character Sets Dialog Box

From the Connect to FTP Site dialog box, select a site, and then click the Properties button.

-or-

If you are already connected to a site, from the Connection menu, choose Site Properties .

Click the Translation tab. and then click the Character Sets button.

The need to translate characters is dictated by differences between the character set used by the

source and the character set used at the destination. In most situations, no translation is

necessary.

If both client and server use the DOS character set, no translation is necessary.

If the client uses the Windows character set and the server uses the ISO-Latin-1 character

set, no translation is necessary.

The FTP Client can translate between the server character set and either the Windows or DOS

character set. These settings apply to ASCII file transfers and characters sent from the server that

are written to the screen.

The options are:

1. 1. 

1. 

1. 

2. 2. 

• • 

• • 

This feature is not available for SFTP connections.

note

Translate

files

Enable translation of ASCII files. Character translations occur when a PC

file is sent to the server and when characters sent from the server are

written to a client file.

Translate

server

messages

Enable translation when characters sent from the server are written to the

screen.

Detect

server Kanji

type

Specify that character translation should be based on the type of Kanji

character set detected in a file or message. This option is available only

when Server is set to EUC, DEC 1983 Kanji, or JIS X0208-1983, and either

Translate files or Translate server messagesis selected. Clear this check

box to use the specified Server Kanji character set at all times.

Client Specify the character set to use on the client PC when Translate files is

selected.The default setting is the current Windows character set.

6.12 Character Sets Dialog Box
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To server

These options are available only when either Translate files or Translate server messages is

selected.

Server Specify the character set to use during ASCII file transfers (if Translate

files is selected) and when translating server messages (if Translate

server messages is selected.

ISO-7/NRC Specify the national character set (NRC) to use for replacement purposes.

Translation replaces certain characters from the ASCII set with accented

characters and symbols for a specific national language. This option is

only available when the Server character set is DEC Supplemental, ISO

Latin-1, or HP Roman 8 and Change Roman-8 to ISO-7 and Change ISO-7

to Roman-8 are selected, or Change MCS to NRC and Change NRC to

MCS are selected.

Change

Roman-8 to

ISO-7

If ISO-7/NRC is set to a value other than US ASCII, select this option to

have Roman 8 characters translated to an equivalent ISO-7 character

when possible. The ISO-7/NRC value determines the character

conversion.

This option is available only when the Server character set is HP Roman

8.

Change MCS

to NRC

Specify whether characters are translated from the DEC multinational

character set (MCS) to the current national replacement character

(NRC) set. The ISO-7/NRC value determines the character conversion.

This option is available only when the Server character set is DEC

Supplemental or ISO Latin-1.

6.12 Character Sets Dialog Box
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From server

These options are available only when either Translate files or Translate server messages is

selected.

Half- to full-

width

Katakana

Specify whether characters are translated from the current half-width

Katakana character set to the full-width Katakana character set.

The Server value determines which Kanji character set is used during

the conversion.

This option is available only when the Server character set is one of the

JIS types (except Shift-JIS), the two DEC Kanji types, and EUC

(Unicode).

Change

ISO-7 to

Roman-8

If ISO-7/NRC is set to a value other than US ASCII, select this option to

have ISO-7 characters converted to equivalent Roman 8 characters. The 

ISO-7/NRC value determines the character conversion. This option is

available only when the Servercharacter set is HP Roman 8.

Change NRC

to MCS

Specify whether characters should be translated from the current

national replacement character (NRC) set to the DEC multinational

character (MCS) set. The ISO-7/NRC value determines the character

conversion. 

This option is available only when the Server character set is DEC

Supplemental or ISO Latin-1.
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More information

Translation Tab (Site Properties Dialog Box))

6.13 Add Smart File Type Dialog Box

Getting there

From the Tools menu, choose Options .

Click the File Types tab, and then click New .

When Smart file transfer is enabled, all filenames with a specified extension are transferred using

the associated transfer method.

Full- to half-

width

Katakana

Specify whether characters are translated from the current full-width

Katakana character set to the half-width Katakana character set.

The Server value determines which Kanji character set is used during the

conversion.

This option is available only when the Server character set is one of the

JIS types (except Shift-JIS), the two DEC Kanji types, and EUC (Unicode).

• 

1. 1. 

2. 2. 

File type Type a file extension to associate with a specific transfer method, or

select a file type from the list.
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More information

Set the Transfer File Type (Transfer Method)

Add a Smart File Transfer Type

Specify a Default Smart File Transfer Type

6.14 Smart Transfer File Type Dialog Box

This dialog box appears when you have selected the Smart transfer method and you are

transferring a file with an undefined file type. Specify what transfer method you want to use for files

with this file extension.

The options are:

Transfer

method

Select the transfer method you want to use for files with this extension.

• • 

• • 

• • 

Save your settings file to add this association permanently to your Smart file transfer list.

note

ASCII Use ASCII transfer for text files, such as .txt  and .html .

Binary Use binary transfer for binary files, such as .exe  files and .doc  files. Binary

files are not converted or translated during the transfer.

Tenex Use Tenex (also known as "Local 8") if you're moving files to or from a server

that uses a non-8-bit byte, such as the DECsystem-20.

6.14 Smart Transfer File Type Dialog Box
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More information

Add a Smart File Transfer Type

Set the Transfer File Type (Transfer Method)

6.15 Confirm File Replace Dialog Box

When If File Exists is set to Ask User , this dialog box opens each time a client or server file being

transferred already exists on the destination. The options are:

Always

ask user

Select this option if you always want to be asked how to handle files with this

extension. For example, you might want to select this option if the same file

extension is used for different file types. This option is not available if Always

ask user has already been specified for this file type.

• • 

• • 

Append server

file to local file

Append the downloaded file to the destination file. This option is only

available for transfers from the host.

Overwrite local/

server file

Overwrite the destination file.

Skip this file Do not transfer this file. If additional files are specified for this

transfer operation, continue with the next file.

Copy to a

different name

Type in the new filename to use in the destination folder, and click

OK.

Copy using a

unique name

Automatically create a unique name for the destination file. The

names of any files that are renamed during the transfer operation are

shown in the FTP command window.

6.15 Confirm File Replace Dialog Box
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More information

Handle Existing Files (Transfer Mode)

Update local/

server file if

older

Overwrite the destination file only if the file being transferred is newer

than the destination file.

• 
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7. Managing Files and Folders

7.1 Managing Files and Folders

Working with Files

Working with Local Folders

Create a Shortcut to a Local File or Folder

Working with Server Directories

Set Default Home Directories

Working with Filename Characters

Filter the Server File Listing

Run the Directory Definition Wizard

Set File and Directory Permissions

Server View Filter Dialog Box

Server File Properties Dialog Box

Go To Folder Dialog Box

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 
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7.2 Working with Files

Commands on the File and Edit menus, and most buttons on the toolbar, apply to folders and files

in the currently active pane. These commands let you rename, delete, and do other directory

management tasks within the FTP Client.

Also, you can right-click a file to access commands in the context menu. For example, to get

information about a file, right-click it and choose Properties .

Double-click a file to open or run it.

More information

Working with Local Folders

Working with Server Directories

Working with Filename Characters

Filter the Server File Listing

In order to display the contents of a server file or run a program located on the server, the file is

copied from the server to your Windows user folder.

note

• • 

• • 

• • 

• • 
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7.3 Working with Local Folders

To work with items on the local PC, use the left pane of the FTP Client. You can browse disk drives

on your computer or local network, create new folders, and do other directory management tasks

within the FTP Client. Commands on the File and Edit menus, and most buttons on the toolbar,

apply to folders and files in the currently active pane.

New folders can be added from the File menu, context menu (right-click), or toolbar. Use the

context menu to create shortcuts to folders.

To view the local directory structure, use the Go to a different folder list box in the upper left corner

of the main window. To see how the current folder fits in the hierarchy on your computer, click the

down arrow in the list box. The Tools menu and toolbar provide access to the Up One Level

command. Also, you can navigate directly to a folder using the Go to command.

To navigate directly to a local folder

From the Tools menu, choose Go to.

Type the name of the directory you want to open.

For example: J:\Payroll\July .

Select Local Computer to indicate that the folder is available on your PC.

More information

View the Local PC Files

Set Default Home Directories

Create a Shortcut to a Local File or Folder

1. 1. 

2. 2. 

2. 

3. 3. 

You can enter UNC (Universal Naming Convention) names for directory paths. There is a 47-

character limit for UNC names, and each name can contain any character, both uppercase or

lowercase, except the following: ? " / | < > * :

The syntax of a UNC name is as follows:

\\<computername>\<sharename>\<pathname>

note

• • 

• • 

• • 
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7.4 Create a Shortcut to a Local File or Folder

To create a shortcut to a local file using the FTP Client

In the left pane, select the files and folders you want to create shortcuts to.

Click the right mouse button to open the context menu.

From the context menu, click Create Shortcut to create a shortcut to each of the selected files

and folders.

The shortcuts are created in the current folder on the PC.

More information

Working with Local Folders

Working with Files

View the Local PC Files

1. 1. 

2. 2. 

3. 3. 

3. 

• • 

• • 

• • 
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7.5 Working with Server Directories

To work with items on the server, use the right pane of the FTP Client. You can browse remote

directories, create new folders, and filter the file listing. Commands on the File and Edit menus, and

most buttons on the toolbar, apply to folders and files in the currently active pane.

New folders can be added from the File menu, context menu (right-click), or toolbar.

To view the remote directory structure, use the Go to a different folder list box in the upper left

corner of the main window. To see how the current directory fits in the hierarchy on your server site,

click the down arrow in the list box. The Tools menu and toolbar provide access to the Up One

Level command. Also, you can navigate directly to a remote directory using the Go to command.

To navigate directly to a remote directory

From the Tools menu, choose Go to.

Type the name of the directory you want to open.

Follow the server's syntax for directory names.

Select site name to indicate that the directory is located on the server.

More information

View the Server Files

Set Default Home Directories

Filter the Server File Listing

Run the Directory Definition Wizard

1. 1. 

2. 2. 

2. 

3. 3. 

• • 

• • 

• • 

• • 
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7.6 Set Default Home Directories

Use default home directories to determine which files you see by default in the FTP Client. The

default server directory determines which files you see in the server pane when you first connect to

a site. There are two kinds of default local home folders. One is the global setting for the FTP

Client, and the other kind is specific to each site that you connect to. Once you've configured a site-

specific local home folder, the FTP Client will show that folder in the local pane, and the default

server home directory in the server pane.

To set the default server directory

Use the right pane to browse for the server directory you want to set as the default.

From the Connection menu, choose Site Properties and then click the Directories tab.

Under Server , click Use Current .

This enters the current server location in the Home directory text box.

Click OK.

To set the default local folder for a specific site

From the Connect to FTP Site dialog box, select a site, and then click the Properties button.

-or-

If you are already connected to a site, from the Connection menu, choose Site Properties .

Click the Directories tab.

Under Local , click Browse and select the PC directory you want to set as the default.

Click OK .

To set the default local folder for the FTP Client

1. 1. 

2. 2. 

3. 3. 

3. 

4. 4. 

To change the default server home directory, you can also right-click the folder you want to

use, and then choose Set Home Directory .

note

1. 1. 

1. 

1. 

2. 2. 

3. 3. 

4. 4. 
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From the Tools menu, choose Options .

Click the Directories tab.

Under Default local home folder , click Browse and select the PC directory you want to set as

the default.

Click OK .

More information

Directories Tab (Site Properties Dialog Box))

General Tab (Options Dialog Box))

Working with Local Folders

Working with Server Directories

1. 1. 

2. 2. 

3. 3. 

4. 4. 

• • 

• • 

• • 

• • 
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7.7 Working with Filename Characters

The FTP Client supports long filenames. Long filenames in Windows can contain spaces. The only

characters that are not allowed are:

The following length limitations apply:

Maximum path (excluding the filename): 246 characters (including drive letter, :  character

and \  character). This limit of 246 allows for the addition of a filename in the standard 8.3

format with the terminating null character.

Maximum filename: 256 characters (including terminating null character)

Maximum fully qualified name (path + filename): Varies slightly with different Windows

operating systems. Use 259 characters to ensure a valid path for all Windows systems.

Working with filenames that contain spaces

When you use FTP or SFTP commands, any filename that contains spaces must be enclosed in

double quotation marks. For rules on how quotation marks are used, see the Quotation Marks in

FTP or SFTP Commands topic.

Working with server filenames that contain prohibited characters or are too long

For file transfers to the PC, the FTP Client automatically ensures that the name given to the file on

your PC is valid in Windows by using the following rules:

Strip all illegal characters. Example: fast*lane  becomes fastlane .

Invalid characters are: \ / : * ? " < > |

If necessary, truncate the filename. In Windows, the length limitations described above are

applied.

The Windows path is always preserved. If the server filename plus the destination Windows

path is greater than the maximum allowed, the server filename is truncated.

If the filename begins with a period, the appropriate number of characters are removed from

the end of the filename. If the filename contains periods, the client determines the location

of the last period in the name and truncates the appropriate number of characters to the left

of the period.

If you want transfers from a server site to automatically derive a valid DOS name when the server

filename is too long or when it contains invalid characters, select the Create Windows file names in

8.3 format option on the Transfer tab in the Site Properties dialog box.

More information

\ / : * ? " < > |

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 
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Quotation Marks in FTP or SFTP Commands

Working with Files

Transfer Tab (Site Properties Dialog Box)

• • 

• • 

• • 
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7.8 Filter the Server File Listing

Using a file filter allows you to view a subset of the files on the server. You can specify a default file

filter or a temporary file filter. If the server directories contain a lot of files, specifying a default filter

provides a way to speed up retrieval and display of directory listings.

To specify a default file filter for a server

From the Connection menu, choose Site Properties and then click the Directories tab.

In the File View Filter box, type a default view filter for all server directory listings for that site.

For example, type *.txt to list all files in the current directory that end in .txt . The

specification must use wildcard characters that are recognized by the type of server running at

the site.

Select OK.

The FTP Client automatically refreshes the server directory listing.

To apply a temporary file filter

From the View menu, choose Filter .

In the Server View Filter dialog box, type a view filter specification.

For example, type *.txt to list all files in the current directory that end in .txt . The

specification must use wildcard characters that are recognized by the type of server running at

the site.

Select OK.

The FTP Client automatically refreshes the server directory listing.

This feature is not available for SFTP connections.

note

1. 1. 

2. 2. 

2. 

3. 3. 

3. 

1. 1. 

2. 2. 

2. 

3. 3. 

3. 
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More information

Working with Server Directories

Server View Filter Dialog Box

Directories Tab (Site Properties Dialog Box)

If you are connected to two servers in the same session, the View menu Filter command

applies to both servers. To apply a filter to only one server, right-click in the display pane

for that server, and select Filter from the context menu.

When a view filter is in effect, the filter is shown in the title bar of the server pane.

To request a listing of all files in the folder, type *  (asterisk) for your view filter

specification.

note

• • 

• • 

• • 

• • 

• • 

• • 
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7.9 Run the Directory Definition Wizard

The Directory Definition Wizard helps you to define the directory format for an unrecognized type

of FTP server. The Wizard allows you to identify the filename and other fields in the directory output

from the current FTP site so that server directory listings can be displayed and interpreted properly

in the right pane of the FTP Client window.

To use the Directory Definition Wizard

Connect to a site.

From the Tools menu, choose Directory Definition Wizard .

Complete the listitems as directed by the wizard.

When you are done specifying the location of fields, click Finish .

The FTP Client automatically refreshes the server directory listing.

If the directory listing is still unusable, re-run the Directory Definition Wizard and continue

experimenting with the location of directory fields until you get better results.

More information

FTP Client Troubleshooting

This wizard should not be used if the files on the FTP site already display properly.

note

To use the Directory Definition Wizard, you must have Server type set to Auto detect (the

default value) on the General tab of the Site Properties dialog box.

note

1. 1. 

2. 2. 

3. 3. 

File name is the only required field. You can leave the other fields undefined.

note

4. 4. 

4. 

5. 5. 

• 
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7.10 Set File and Directory Permissions

You can change file permissions on the server using the server pane or the FTP command line. You

can also configure global defaults for new files and directories. For individual sites, you can

configure the client to query you for permission values each time you transfer a file or create a new

directory.

To change file and directory permissions using the server pane

Connect to a UNIX or Linux host.

In the server pane, select one or more files or directories.

Right-click your selection and choose Properties .

Change the attributes of the selected item(s) using either of the following techniques:

In the Permission Mode box, type a three digit number that is a valid value for the UNIX 

chmod command. Valid values have digits from 0 to 7.

Under Owner , Group , and Public , select options to allow each user type permission to

read, write, or execute.

Click OK .

To configure global defaults for transferred files or newly created directories

Go to Tools > Options

To set default permissions for uploaded and downloaded files, use the File Attributes tab.

To set default permissions for newly created directories, use the Directory Attributes tab.

Click OK .

To set permissions each time you transfer a file or create a directory

Open the site properties dialog box.

To set permissions each time you create a directory on the server, click the Directories tab

and select Show attributes before creating directory .

To set permissions each time you transfer a file, click the Transfer tab and select either or

both of the following options: Show download options before transfer and Show upload

options before transfer .

Click OK .

1. 1. 

2. 2. 

3. 3. 

4. 4. 

• • 

• • 

5. 5. 

1. 1. 

2. 2. 

3. 3. 

4. 4. 

1. 1. 

• • 

• • 
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To change file and directory permissions using the FTP command line

Connect to a UNIX or Linux host.

Press F7 to display the command line if it is not already visible.

Enter a UNIX chmod command using a numeric permission mask.

For example, the following commands sets attributes to -rw-r--r--  for the specified file.

More information

Use the FTP Command Line

Server File Properties Dialog Box

Set Time and Date of Downloaded Files

Change the Filename when Downloading

Change the Filename when Uploading

1. 1. 

2. 2. 

3. 3. 

3. 

chmod 644 myfile.htm

Permissions changes you make to directories are not recursive; that is they do not affect the

files within the directory.

note

• • 

• • 

• • 

• • 

• • 
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7.11 Server View Filter Dialog Box

From the FTP Client View menu, choose Filter

Use the Server View Filter dialog box to request a remote site directory listing that shows server

files of a specific type.

Type a wildcard specification. For example, type *.txt to list all files in the current directory that

end in .txt . The specification must use wildcard characters that are recognized by the type of

server running at the site. When you click OK , the server directory listing refreshes in the right pane,

showing only the files that match your specification.

7.12 Server File Properties Dialog Box

Start the FTP Client.

This opens the Connect to FTP Site dialog box. (If the FTP Client is already running and

this dialog box is not open, go to Connection > Connect .)

Connect to a site and then select a file or folder in the server pane.

From the File menu, choose Properties .

This dialog box displays information about the currently selected server file or directory. You can

also use it to set permissions on a UNIX or Linux server.

Permissions changes you make to directories are not recursive; that is they do not affect the files

within the directory.

Getting there

This feature is not available for SFTP connections.

When a view filter is in effect, the filter is shown in the title bar of the server pane.

To request a listing of all files in the folder, type *  (asterisk) for your view filter

specification.

note

• • 

• • 

• • 

Getting there

1. 1. 

1. 

2. 2. 

3. 3. 

Attributes Displays the current attributes.
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Permission Mode Type a three digit number that is a valid value for the UNIX chmod

command. Valid values have digits from 0 to 7.

7.12 Server File Properties Dialog Box
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More information

Set File and Directory Permissions

Working with Server Directories

7.13 Go To Folder Dialog Box

From the FTP Client Tools menu, choose Go to.

Type the name and path of the folder you want to open.

Click Local Computer to specify a path on the local computer.

If you are connected to a server, the server name is shown. Click this option to specify a

path on the server.

More information

Working with Local Folders

Working with Server Directories

Owner, Group, and

Public

Select options to allow each user type permission to read, write, or

execute the currently selected item.

• • 

• • 

Getting there

• • 

• • 

• • 

• • 
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8. Customizing FTP Client Startup

8.1 Customizing FTP Client Startup

You can customize how the FTP Client starts using shortcuts, startup switches, and script files.

You can use Windows shortcuts to provide quick and easy access to the Reflection FTP Client and

to your servers. You can create a shortcut to:

Open a settings file and display a list available sites

Connect to a specific host site

More information

Create a Shortcut to Load a Settings File

Create a Shortcut to Connect to a Site

FTP Client Startup Switches

Startup Command Examples

Run a Script File at Startup

Example of Starting the Client with a Script File

• • 

• • 

• • 
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• • 

8. Customizing FTP Client Startup

8. Customizing FTP Client Startup 103



8.2 Create a Shortcut to Load a Settings File

You can create a shortcut that loads an FTP Client settings file and automatically opens the 

Connect to FTP Site dialog box showing a list of available sites.

To create a shortcut that launches the Reflection FTP Client and loads a settings file

From the File menu, select Save As.

(Optional) Type a new name for the file you are saving.

Select the Save shortcut on desktop option in the lower left corner of the Save Settings dialog

box.

Click Save.

More information

FTP Client Settings Files

Connect to FTP Site Dialog Box

8.3 Create a Shortcut to Connect to a Site

You can create a shortcut that launches the FTP Client and automatically connects to a server.

To create a shortcut that launches the Reflection FTP Client and connects to a site

The Connect to FTP Site dialog box opens when you start the FTP Client. You can also open it

by choosing Connect from the Connection menu.

Right-click on any site in the list and select Create Shortcut .

You will see a message telling you that a shortcut has been created on the desktop.

Click OK.

More information

Connect to FTP Site Dialog Box

1. 1. 

2. 2. 

3. 3. 

4. 4. 
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8.4 FTP Client Startup Switches

You can start the FTP Client and provide command line parameters that automatically connect to a

predefined site, run a specified script file, connect using a settings file, or connect to a server

specified with a URL.

You can set up a shortcut with a startup command that automatically executes the startup

command when you double-click it. The properties you specify for the shortcut determine

whether the Client runs in a window or runs minimized on the desktop when you start it.

You can enter a startup command in the Open box when you use the Run command on the 

Start menu.

Startup Command Syntax

• • 

• • 

<executable>.exe [<site>] /<switch> <parameter>

<executable>.exe Provides the path and name of the FTP executable file,

for example:

"FTP_INSTALL_FOLDERrftpc.exe"

<site> Specifies a site defined in a settings file. The site

properties are in effect when the client starts. If the site

name contains spaces, enclose it in quotation marks,

for example "ADA Home" . 

When included, the <site>  argument is always the first

argument on the command line. When used in

conjunction with the /W switch, the <site>  argument

is ignored. 

If the defined site is not in the default settings file

(Settings), use the /RFW switch to specify the settings

file that includes the site definition.

8.4 FTP Client Startup Switches
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Startup Switches

/<switch> <parameter> Use one or more of the switches listed below to specify

the operations you want to perform when the client

starts up:

/D <diagnostic file> Directs the client to record in the specified file all

communications between the client and the server, as

well as other diagnostic information that may be useful

for troubleshooting. The specified diagnostic file is

placed in your My Documents folder. This file is

refreshed each time you start the client.

/E Directs the client to log events to the Application event

log. Note: The diagnostic file created with /D includes

more detailed information than this event log.

/FMIGRATE Launches the Reflection F-Secure Migration Wizard,

which you can use to migrate F-Secure profiles to

Reflection settings files.

/L <log file> Directs the client to record in the specified log file all

communication between the client and the server to

which it connects. This is a cumulative log file; new

information is added after existing information.

/N Suppresses the display of the Reflection startup screen.

/RFS <script file> Runs the specified script. If the script ends in a QUIT

command, the client shuts down when the script

completes.

/RFW <settings file> Allows you to connect using the specified settings file.

/X <export file> Launches the Export Settings dialog box directly

without launching the main client window.

/W <URL> Connects to the server specified in the <URL>

parameter. The syntax is shown here:

rftpc[.exe] /W ftp://

[username[:password]@]hostname[:port][/

directory]
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More information

Startup Command Examples

8.5 Startup Command Examples

The following example command runs the FTP Client ( Rftpc.exe ) and connects to a site named

West Coast, which is defined in the default settings file.

In the example above, quotation marks must surround the executable file specification because the

path specifies a folder name that contains a space. Similarly, the site name is surrounded by

quotation marks because it contains a space in the name.

The next example command uses the /W switch to specify the URL for an FTP site and the /L

switch to direct the FTP Client ( rftpc.exe ) to log all client/server communication to a log file

named Ftpinfo.log .

The following example command tells the FTP Client to connect using a settings file and run a

script file. The /RFW  switch directs the FTP Client to connect using the settings file Myfile.rfw .

The /RFS  switch directs the FTP Client to run the script file Transfer.rfs  after connecting to the

server specified in the settings file.

More information

FTP Client Startup Switches

/? Displays the list of allowable start-up commands.

• 

"FTP_INSTALL_FOLDER\rftpc.exe" "West Coast"

"FTP_INSTALL_FOLDER\rftpc.exe" /W ftp://ftp.myco.com /L Ftpinfo.log

"FTP_INSTALL_FOLDER\rftpc.exe" /RFW 
"C:\Mypath\Myfile.rfw" /RFS "C:\Mypath\Transfer.rfs"

• 
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8.6 Run a Script File at Startup

You can start the client and provide command line parameters that automatically execute all the

commands in a script file. This allows you to automate sequences of commands.

You can set up a shortcut with a startup command that automatically executes a script

when you double-click it. The properties you specify for the shortcut determine whether the

client runs in a window or runs minimized on the desktop when you start it.

You can enter a startup command in the Open box when you use the Run command from

the Start menu.

Startup Command Syntax to Execute a Script File

Use a space to separate each argument in the command line.

Provides the path and name of the FTP Client executable file.

For example:

Specifies a previously defined site. The site properties are in effect when the client starts. If the

FTP site name contains spaces, enclose it in quotation marks, for example "ADA Home" .

When included, the <site>  argument is always the first argument on the command line. When

used in conjunction with the /W switch, the <site>  argument is ignored.

Provides the path and name of the FTP script file. If the script file name or path contains spaces,

enclose it in quotation marks , for example "C:\My Script Files\Get lab reports.rfs" .

More information

FTP Client Startup Switches

Example of Starting the Client with a Script File

• • 

• • 

<executable>.exe [<site>] /RFS <script file>

<executable>.exe

"FTP_INSTALL_FOLDERRftpc.exe" <site>

/RFS <script file>

• • 

• • 
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8.7 Example of Starting the Client with a Script File

The following command runs the FTP Client, connects to the FTP site "Central" and executes an

FTP script file named Upload.rfs .

In this example, the FTP Client starts and automatically connects to the FTP site "Central". The site

properties defined for the "Central" FTP site are in effect when the script runs.

More information

Run a Script File at Startup

FTP Scripting

Rftpc.exe Central /RFS Upload.rfs

Any site or script filename containing spaces must be enclosed in quotation marks. For

example:

note

Rftpc.exe "My Site" /RFS "Central files download.rfs"

• • 

• • 
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9. FTP Client Troubleshooting

9.1 FTP Client Troubleshooting

Identifying the Source of the Problem

Troubleshooting FTP Client Connections

Troubleshooting FTP File Transfer Problems

Troubleshooting FTP Directory Listing

Secure Shell Log File

Troubleshooting FTP Site-to-Site Transfer

FTP Client Error messages

Windows Sockets Error Messages

Error Messages

• • 
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• • 
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9.2 Identifying the Source of the Problem

When you encounter a problem with the Reflection FTP Client, it may help to compare the behavior

to that of another client. You can use the Microsoft FTP client to open a connection to the FTP

server where the problem occurs; then try using this client to duplicate the operation that causes

the problem.

If you can duplicate the problem when you use a different FTP client, one of these conditions may

apply:

The server you are connecting to does not support the FTP operation you are attempting.

The server you are connecting to is configured incorrectly.

You are specifying incorrect information in your command (for example, you are specifying

a non-existent path or filename when attempting a file transfer).

If the problem only occurs when using the Reflection FTP Client (you can't duplicate the problem

when you connect to the server using a different FTP client), check the troubleshooting solutions.

More information

Troubleshooting FTP Client Connections

Troubleshooting FTP File Transfer Problems

Troubleshooting FTP Directory Listing

Troubleshooting FTP Site-to-Site Transfer

• • 
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9.3 Troubleshooting FTP Client Connections

Use this topic to troubleshoot problems making connections using the FTP Client.

Configuring Connections

Did you enter your server name, user name, and password correctly? If you are connecting

to a case-sensitive server, be sure to use the correct case when making these entries.

Does your site use a passthrough server or SOCKS proxy server to ensure that only

authorized users have access to server sites? If so, you should configure the client to

connect via the firewall or SOCKS proxy server.

When opening a connection, the server name you provide is resolved via the HOSTS file or a

domain name server. If you have no domain name server on the local network and don't use

a HOSTS file, you must specify the full IP address of the host server. For example:

124.24.36.85

If the FTP server is not running on the remote system, you can't connect.

Server response time can be affected by the distance between sites. If you see the message

"Connection timed out" when trying to connect to a server, increase the value of Timeouts in

seconds on the Connection tab of the Site Properties dialog box.

If the FTP Client is unable to determine the server type, server directory listings may display

incorrectly. You can use the Directory Definition Wizard to modify the directory format.

If you are having trouble making a Secure Shell connection, use the Secure Shell log to get

troubleshooting information.

Connection Troubleshooting

Error message: "Could not resolve host address."

Several things can cause this message to appear:

The host name or IP address you entered for the server is invalid. Re-enter the host name; if

you are connecting to a case-sensitive server, be sure to use the correct case.

The host name you provide is resolved via the HOSTS file or a domain name server. Is the

computer that acts as the domain name server working? Has the HOSTS file on your PC

been corrupted? If no domain name server or HOSTS file is available, you must specify the

full IP address of the host server. For example: 124.24.36.85.

You have entered an IPv6 address, but have not enabled IPv6 support on your PC. Contact

Microsoft for more information.

You must have an appropriately configured IP router (gateway) in order to connect to

servers outside your own network. Check to see whether the computer serving as the router

is up and running.

• • 

• • 

• • 

• • 
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Error message: "Connection timed out."

Server response time can be affected by the distance between sites. If you see this message when

trying to connect to a server, increase the Connect Timeout setting to give the server more time to

respond during the login process.

Reflection FTP hangs when you try to connect

On some systems, turning off the use of animation (such as showing a waving flashlight while you

are waiting for a directory listing) fixes display problems that cause Reflection to hang when you

attempt a connection. To disable the use of animation, open the Tools menu, click Options , open

the Preferences tab and enable Do not use animation .

Host cannot respond to the PWD command

By default, Reflection sends a PWD command when you connect to your server. Some servers don't

support this command. Press F7 to open the command window before you try connecting to your

server. If the server returns an error after Reflection sends the PWD command, try enabling this

setting. To configure Reflection to connect without the PWD command, open the Directories tab of

the Site Properties dialog box and select Don't send PWD Command .

Error Message: PASV is not implemented by the server

By default, the client connects using the PASV command. This causes the client to initiate a

separate data connection for directory listings and file transfers, which is required for connections

through some firewalls. If your server does not support the PASV command, you can disable the 

Use passive mode setting on the Connection tab of the Site Properties dialog box.

More information

Secure FTP Client Connections

Connection Tab (Site Properties Dialog Box)

Run the Directory Definition Wizard

Secure Shell Log File

• • 
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• • 
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9.4 Troubleshooting FTP File Transfer Problems

If you're having trouble transferring files using the FTP or SFTP client, consult the following list:

You must be connected to a server before you can transfer files.

If a transferred file is not usable (for example, you can't unzip a zipped file, you can't run an

executable file, or you can't read an ASCII file), be sure that you are selecting the correct file

transfer method prior to transferring the file.

Transfers to a server may be unsuccessful if you don't have write permission to the

destination directory on the server.

If an "Access denied" message displays when you attempt to transfer a server file to your

PC, you have a read-only file in the PC destination directory that has the same name as the

file you are trying to receive, or you do not have write permission to the PC directory.

If you see an error message when you attempt to transfer files between two remote hosts,

the sending or receiving server may not be configured to support this feature.

If a transferred ASCII file contains incorrect characters, you may need to use character

translation to preserve the characters present in the source file when they are transferred to

the destination file. When necessary, the FTP Client can translate between the server

character set and either the Windows or DOS character set. Character translation ensures

that characters present in the source character set are translated to characters available in

the destination character set. For example, if you transfer files from a server that uses the

DOS character set for use in a Windows application, or if you want to transfer an ASCII file

that contains accented characters and symbols for a specific national language, you need to

set character translation options to perform necessary translation during file transfer. See

the Character Sets Dialog Box topic for more information.

If you are having trouble transferring files when the file names contain spaces, quotation

marks, or wildcard characters, see the Quotation Marks in FTP or SFTP Commands topic for

more information.

If you are having trouble canceling a file transfer you may need to reconnect to the server.

Some servers close your connection if you cancel a transfer while you are receiving (getting)

a server file.

If File Exists settings apply only to transfers within the Reflection FTP Client. If you use drag-

and-drop to transfer a file from a FTP Client display pane to your desktop or an open

Windows Explorer window, Windows will always display a Confirm File Replace dialog box

whenever a file with the same name exists in the selected location, regardless of the

configuration of the Reflection FTP Client. To take advantage of the currently configured

FTP Client option, always use the FTP Client panes for drag-and-drop transfers.

• • 
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9.5 Troubleshooting FTP Directory Listing

Consult the following list if you are having trouble obtaining directory listings at an FTP or SFTP

site:

Trouble obtaining a directory listing or Server returns error "425 Can't open data

connection"

If you don't see a directory listing in either the server pane or the command window, your server

may not support the PASV command. Try clearing the Use passive mode setting in the Connection

tab of the Site Properties dialog box.

Trouble seeing all files in a server directory

You may have specified a default wildcard filter for the site's server directory listings. The wildcard

filter limits directory listings to files of a specific type. For example, if the filter specifies *.txt ,

directory listings will show only files that match the wildcard (that is, files ending in .txt ).

The default wildcard filter for server directory listings is set on the Directories tab in the Site

Properties dialog box.

When a wildcard filter is in effect, the filter will be shown in the title bar of the FTP Site pane

(the right pane).

To temporarily override the default wildcard filter for server directory listings, use View > 

Filter . To see all files and folders in the directory, type *  (an asterisk).

Incorrect or empty server file display when connecting to a UNIX server using SFTP

Try changing the Use structured listing data setting (Site Properties > Security > Secure Shell ) if

you are connecting using SFTP and the server pane display is missing or is not correctly displayed.

This setting specifies which data list style sent by the server is used to create the directory display

in the right pane of the FTP Client. When this setting is not selected (the default), the FTP Client

uses the standard UNIX-style data list. When it is selected, the FTP Client uses the structured data

list.

You see an error message saying "The system cannot find the path specified" when you

connect to the server

This error may indicate that the FTP Client is trying to find a local file path that does not exist.

Check the local Home folder setting to be sure that the folder path exists on your computer. To

view or edit this setting, open the Site Properties dialog box, click Directories , then find Home

folder under Local .

More information

• • 

• • 

• • 
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Run the Directory Definition Wizard

9.6 Secure Shell Log File

Reflection maintains a log file with information about your last Secure Shell connection. Use either

of the following techniques to view this log for the FTP Client:

Start logging ( Tools > Start Logging ) to send log information to a file.

Open the FTP command window ( View > Command Window) to view the log on screen.

• 

• • 

• • 

You can use the Logging Level setting to determine how much information is written to the

Secure Shell log. This setting is available on the Secure Shell Settings dialog box -- General

tab.

note

9.6 Secure Shell Log File
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9.7 Troubleshooting FTP Site-to-Site Transfer

If you see any of the following error messages when you attempt to transfer files between two

remote hosts, the sending or receiving server may not be configured to support this feature:

500 Illegal PORT command

501 IP address for data destination does not match client's

425 Can't open data connection

502 PASV command not implemented by this server

When the FTP Client encounters this problem, it attempts to transfer to the local PC, and then to

the target site, after the error is received. Note that even though the transfer may complete

successfully, you will see the error message before the transfer is completed.

If you regularly transfer between servers that don't support direct site-to-site transfer, you can

configure the FTP Client to force all site-to-site transfers to copy files first to the local machine then

to the destination server. This configuration allows you to transfer between sites without seeing

one of the error messages listed above.

To force all site-to-site transfers to copy files first to the local computer

From the Tools menu, choose Options .

On the Preferences tab, select Force site to site transfers through local machine , and then

click OK .

Review the following for more information about configuring servers to support direct site-to-site

transfer.

Sending server configuration

Site-to-site transfer feature requires that any FTP server sending a binary file must accept a PORT

command from the Reflection FTP Client to an IP address that is different from the client's IP

address. (On some servers this support may be disabled for security reasons.) The PORT

command specifies the TCP PORT to which the data should be sent. If the sending server does not

accept this use of the PORT command, you will see two server error messages: usually a "500

Illegal PORT command" or a "501 IP address for data destination does not match client's" from the

sending server, followed by a "425 Can't open data connection" from the receiving server. You will

also see a file of zero bytes created on the receiving server because the file index is created prior to

receiving any data. To enable site-to-site transfer, contact the administrator of the sending server to

determine whether PORT commands to a different IP address can be enabled on the server.

Receiving server configuration

• • 
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Site-to-site transfer requires that any FTP server receiving a binary file must accept a PASV

command from the Reflection FTP Client and return the PORT information to be passed on to the

sending server. If the receiving server does not accept the PASV command, the site-to-site transfer

will fail with an error message: "502 PASV command not implemented by this server". To enable

site-to-site transfer, contact the administrator of receiving server to determine whether PASV can

be enabled on the server.

More information

Transfer Files between Two Remote Sites• 
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9.8 FTP Client Error messages

Following is a list of the FTP Client error messages that may appear and an explanation of how to

resolve the error condition.

9.8 FTP Client Error messages
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A connection has not been established.

Command line error. You issued a command to a server (for example PWD, CD, DIR, LS, or QUOTE 

<command> ) but you aren't currently logged in to the server. Open a server connection.

Access denied.

You cannot access the protected file or folder. Check that you have correct permissions for the

operation you attempted.

Already connected to a site.

Command line error. You issued an OPEN  or PASSTHRU  command, but you are already logged in to

a server. Use the CLOSE  command to close the current connection prior to opening a new one.

Connection timed out.

When connecting to a server, the FTP Client waits up to <n>  seconds for a response from the

server. If nothing is received within the period specified, this message is displayed; in this case, try

to connect again. If the message appears again, increase the connection timeout value to give the

server more time to respond during the login process. To do this, open the Connection tab and

edit the Connect text box under Timeout in seconds ; or enter SET TIMEOUT-CONNECT  at the

command line.

Could not resolve host address.

Several things can cause this message to appear:

The host name or IP address you entered for the server is invalid. Re-enter the host name; if

you are connecting to a case-sensitive server, be sure to use the correct case.

The host name you provide is resolved via the HOSTS file or a domain name server. Is the

computer that acts as the domain name server working? Has the HOSTS file on your PC

been corrupted? If no domain name server or HOSTS file is available, you must specify the

full IP address of the server. For example: 124.24.36.85.

You must have an appropriately configured IP router (gateway) in order to connect to FTP

or SFTP servers outside your own network. Check to see whether the computer serving as

the router is up and running.

Command <command>  needs more arguments.

Command line error. The command you entered requires one or more arguments. Type help 

<command>  at the FTP command line for a quick summary of the syntax for the command or

consult the online help.

File already exists.

File transfer to the client was unsuccessful because the If File Exists file transfer mode is set to 

Cancel and a file with the same name as the server file already exists on the local computer.

• • 

• • 

• • 
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Out of memory.

There is not enough memory on the local computer. Close other open Windows applications and

try again.

Session timed out.

After you are connected to a server, the client waits up to \<n> seconds for data packets being

transferred to or from the host. If nothing is received within the period specified, this timeout error

appears; in this case, try the operation again. If you have received repeated timeout errors,

increase the session timeout value. To do this open the Connection tab, and edit the Session text

box under Timeout in seconds , or use SET

TIMEOUT-SESSION  at the command line. (Connection timeouts are governed by a separate 

Connect text box). 

Server response time can be affected by the distance between sites. Specifying a higher value

gives the server more time to respond.

Unknown command <command> . Type 'help' for a list of valid commands.

Command line error. The command you entered is not recognized. Type help at the FTP

command line for a list of the available FTP commands, type help <command>  for a summary of

the syntax for a specific command, or see the Command Reference topic.

502 PASV command not implemented by this server

If you receive an error message saying that PASV is not implemented by the server, you should

disable the Use passive mode setting, which is enabled by default. This setting supports

connections through some firewalls.

More information

Connect to a Site

Connection Tab (Site Properties Dialog Box)

Command Reference

• • 

• • 

• • 
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9.9 Windows Sockets Error Messages

Following is a list of the Windows Sockets error messages that may appear during a Reflection FTP

Client session and an explanation of how to resolve the error condition. These error messages

(which are all preceded by the identifying string "WINSOCK error:") are returned by the Windows

Sockets library if an error occurs in the network interface layer between Windows and the TCP/IP

stack you are using. The Windows Sockets library (supplied in a module called Wsock32.dll ) is

included as part of the Windows operating system.

For some network Windows Sockets implementations, when you are connected to a server, several

things can cause this message to be displayed:

You tried to start a file transfer or perform a directory operation (such as changing

directories or refreshing the current directory). If you see this error when attempting to

transfer a file or to obtain a directory listing, then your network implementation does not

work with the FTP Client.

You started another instance of the FTP Client and tried to open another connection to the

same server. If you get this error message when trying to connect, it indicates that your

network implementation supports only one connection at a time to a given server. You

cannot start separate instances of the FTP Client and attempt to connect to the same

server with each instance.

CONNECTION REFUSED

The connection attempt was unsuccessful due to a problem on the host; possibly the host is down
or the server is not running at this time. Wait a while, and then try to connect again.

CONNECTION RESET BY PEER

During a file transfer, the remote host reset the server connection. Close the server connection,
reconnect, and try the transfer again.

CONNECTION TIMED OUT

The attempt to connect to a server was timed out by your network software without establishing a
connection. This may be because the server is not running. Wait a while, and then try to connect
again.

NETWORK IS DOWN

The Windows Sockets implementation has detected that the network subsystem has failed. Your
network should be restarted.

NETWORK IS UNREACHABLE

The network can't be reached from this host at this time. This error can occur when you use an IP
router (gateway) to connect to servers outside your own network. The message indicates that one
of the IP routers along the path from your gateway to the destination networks is down. Contact

• • 

• • 
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your system administrator, who can check the hops between your gateway and the destination
network.

NO BUFFER SPACE AVAILABLE

There are too many open connections. This error condition can occur when opening a connection to
a server or transferring a file, or when the client requests server directory information. Close
other open server connections or applications that use Windows Sockets and try the operation
again. Check your network documentation for information about how to increase the buffer space
for which your network is configured.

OPERATION NOT SUPPORTED ON SOCKET

The client must open a data session prior to performing a file transfer or directory listing
operation. A data session can't be opened using your network's Windows Sockets implementation.

SOFTWARE CAUSED CONNECTION ABORT

While transferring files to or from the server, the virtual circuit used for the server
connection was aborted due to a timeout or other failure (possibly the host went down, or the FTP
or SFTP server is not running). Close the server connection, reconnect, and try the transfer
again.

TOO MANY OPEN FILES

To solve this problem, exit Windows, increase the Files=  setting in your Config.sys  file and
reboot your PC. If you still get this message, try closing other open client sessions and then

9.9 Windows Sockets Error Messages
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try to open the connection again. If your problem is still unresolved, contact the manufacturer
of your Wsock32.dll  for help.

More information

FTP Client Error Messages• 
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Could not resolve host address

Several things can cause this message to appear:

The host name or IP address you entered for the server is invalid. Re-enter the host name; if

you are connecting to a case-sensitive server, be sure to use the correct case.

The host name you provide is resolved via the HOSTS file or a domain name server. Is the

computer that acts as the domain name server working? Has the HOSTS file on your PC

been corrupted? If no domain name server or HOSTS file is available, you must specify the

full IP address of the host server. For example: 124.24.36.85.

You have entered an IPv6 address, but have not enabled IPv6 support on your PC. Contact

Microsoft for more information.

You must have an appropriately configured IP router (gateway) in order to connect to

servers outside your own network. Check to see whether the computer serving as the

router is up and running.

Connection timed out

Server response time can be affected by the distance between sites. If you see this message

when trying to connect to a server, increase the Connect Timeout setting to give the server more

time to respond during the login process.

Reflection FTP hangs when you try to connect

On some systems, turning off the use of animation (such as showing a waving flashlight while

you are waiting for a directory listing) fixes display problems that cause Reflection to hang when

you attempt a connection. To disable the use of animation, open the Tools menu, click Options ,

open the Preferences tab and enable Do not use animation.

Host cannot respond to the PWD command

By default, Reflection sends a PWD command when you connect to your server. Some servers

don't support this command. Press F7 to open the command window before you try connecting to

your server. If the server returns an error after Reflection sends the PWD command, try enabling

this setting. To configure Reflection to connect without the PWD command, open the Directories

tab of the Site Properties dialog box and select Don't send PWD Command.

PASV is not implemented by the server

By default, the client connects using the PASV command. This causes the client to initiate a

separate data connection for directory listings and file transfers, which is required for connections

through some firewalls. If your server does not support the PASV command, you can disable the 

Use passive mode setting on the Connection tab of the Site Properties dialog box.

Server returns error "425 can't establish data connection"

• • 

• • 
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If you don't see a directory listing in either the server pane or the command window, your server

may not support the PASV command. Try clearing the Use passive mode setting in the 

Connection tab of the Site Properties dialog box.

System cannot find the path

This error may indicate that the FTP Client is trying to find a local file path that does not exist.

Check the local Home folder setting to be sure that the folder path exists on your computer. To

view or edit this setting, open the Site Properties dialog box, click Directories , then find Home

folder under Local.

10. Using the FTP Command Window

10.1 Using the FTP Command Window

The FTP Command Window

Clear the Command Window

Use the FTP Command Line

FTP and SFTP Command Syntax

Quotation Marks in FTP or SFTP Commands

10.2 The FTP Command Window

The FTP Client command window shows the data sent to and from the server and also includes the

FTP Command line, which you can use to enter FTP or SFTP commands. Use View > Command

Window to show or hide the command window.

An identifying color is assigned to each type of client/server communication that displays in the

window. For example, if you are using the Windows default color scheme:

• • 

• • 

• • 

• • 

• • 

Color of

text

Meaning

black A command status message received from the server (command status

messages are the server's responses to FTP or SFTP commands issued by

the client)

royal

blue

A Reflection FTP or SFTP command entered at the FTP command line
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Color of

text

Meaning

dark

blue

A data channel response from the server, generally a file listing. After a

connection is made, this color is also used to display the presumed server

type.

green A client FTP or SFTP command that the FTP Client is sending to the server
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More Information

Use the FTP Command Line

Clear the Command Window

FTP and SFTP Command Syntax

Command Reference

10.3 Clear the Command Window

TO CLEAR THE FTP CLIENT COMMAND WINDOW

In the Command window, click the right mouse button and select Clear All .

More information

The FTP Command Window

Color of

text

Meaning

red An error message

If the window background for your current Windows color scheme is set to blue, green,

black, or red, the client changes the identifying colors used in the datacomm display

window to ensure that text is visible against the window background. The display color

for messages received from the server defaults to the color of window text in your

current Windows color scheme.

If you are connected to two sites in the same FTP Client window, you can use the

command line to view communication between the client and the server, but you cannot

enter commands. Commands sent to and from the second server are preceded by this

identifier: [Server 2]. If there is more than one line of output (such as directory listings

and multi-line banners), only the first line has this identifier.

note
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10.4 Use the FTP Command Line

The FTP Client command line provides an alternate way for you to communicate with the server.

You can enter FTP or SFTP commands on the FTP command line to move files between the FTP

server and your PC.

From the View menu, choose Command Window to toggle the command window display.

The FTP command line appears at the bottom of the command window.

To enter commands

Click in the command line or press Shift+F7 to move the cursor to the command line.

Enter an FTP or SFTP command, depending on your connection type.

Press the Enterkey to execute the command.

The FTP Client keeps a list of up to 50 commands from the current session. You can use the drop-

down arrow on the right side of the command line to recall items from this list.

More Information

FTP and SFTP Command Syntax

FTP Scripting

Command Reference

• • 

1. 1. 

2. 2. 

3. 3. 

If you are connected to two sites in the same FTP Client window, you can use the command line

to view communication between the client and the server, but you cannot enter commands.

Commands sent to and from the second server are preceded by this identifier: [Server 2]. If

there is more than one line of output (such as directory listings and multi-line banners), only the

first line has this identifier.

note
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10.5 FTP and SFTP Command Syntax

FTP Command Index

SFTP Command Index

Case is not important for commands and keywords entered at the FTP command line. Depending

on your FTP server computer, however, passwords, directory names, filenames, and other server-

specific information may be case sensitive.

The FTP Client accepts abbreviated versions of commands, requiring that you type only as much of

the command keyword as is necessary to make it unique. For example, the GET  command can be

abbreviated to G; to get the server file jokes.old  you could enter g jokes.old at the FTP

command line.

In the command references in this guide, the following conventions apply:

When parameters are enclosed in angle brackets, they represent a string that must be added

to complete the command. For example, <clientfile> means you must give a complete

path to clearly reference a particular file. Do not include the brackets when entering the

parameter.

A vertical bar separates mutually exclusive options. For example, <servername> | <ip 

address>  means you may use either of the options, but not both.

Parameters enclosed in square brackets indicate optional components of a command; that

is, any information contained within a pair of such brackets can, but need not, be included in

the command. For example, the following indicates that the LCD command can be used

with or without a PC directory:

More information

Quotation Marks in FTP or SFTP Commands

Using the FTP Command Window

FTP Scripting

Use the FTP Command Line
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lcd [<pc directory>]
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10.6 Quotation Marks in FTP or SFTP Commands

If a command takes only one argument, no quotation marks are required. For example:

With commands that take more than one argument, any argument that contains spaces must be

enclosed in double quotation marks. For example, to transfer the server file Account History  to

the PC and name it Accthist.txt , you would enter this command:

If an argument begins with a double quotation mark, all double quotation marks in the argument

must be doubled. For example, to transfer the server file "Remembering You", you would enter a

command in this format:

CD Travel Agents

GET "Account History" TO Accthist.txt

GET ""Remembering You""

10.6 Quotation Marks in FTP or SFTP Commands
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11. FTP Scripting

11.1 FTP Scripting

Options for Automating FTP Client Transfers

More information

FTP Client Scripting

Record a Script

Run a Script

Edit a Script

FTP Client Script File Format

Which Actions Are Captured by the Script Recorder?

Password Security within Scripts

Commands for Error Handling

Running a Script as a Background Task

Creating Script Log Files
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11.2 FTP Client Scripting

FTP Client scripts allow you to automate connection and file transfer operations. For example, you

can automate file transfers to and from a server. Automated transfers can be carried out without

the need to interact directly with the FTP Client.

A script file is an ASCII text file that contains a sequence of FTP (or SFTP) commands. Each

command must be on a separate line. You can create a script using the Script Recorder. You can

also create a new script or modify an existing script using a text editor (such as Notepad).

Use the FTP Client script recorder to record actions as commandsMDASHyou do not have to do

any writing or programming to create a script that can be played back later. Scripts can automate

many sorts of tasks (for example, configuring file transfer options, connecting to an FTP site, or

transferring files).

When you play back a script, commands are executed as though they had been entered at the FTP

command line.

More information

Record a Script

Run a Script

Edit a Script

FTP Client Script File Format
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11.3 Record a Script

Use the FTP Client script recorder to record actions as commandsMDASHyou do not have to do

any writing or programming to create a script that can be played back later. Scripts can automate

many sorts of tasks (for example, configuring file transfer options, connecting to an FTP site, or

transferring files).

To record a script

From the Script menu, choose Start Recording.

When the script recorder is active, a camera icon appears in the status bar.

Perform the actions you want to record.

From the Script menu, choose Stop Recording.

In the Save Script dialog box, type a name for the script in the File name box.

The default extension for script files is .rfs .

Click Save.

More information

Run a Script

Edit a Script

Which Actions Are Captured by the Script Recorder?

FTP Scripting

1. 1. 

1. 

2. 2. 

3. 3. 

4. 4. 

4. 

5. 5. 

You cannot record scripts when you are connected to two sites in the same session.

note
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11.4 Run a Script

From the Script menu, choose Run Script .

In the Run Script dialog box, select the script you want to run.

Click Open to play back the selected script.

More information

Running a Script as a Background Task

Creating Script Log Files

FTP Client Scripting

11.5 Edit a Script

From the Script menu, choose Edit Script.

In the Edit Script dialog box, select the script you want to edit.

Click Open to open the file in Notepad.

More information

FTP Client Script File Format

Password Security within Scripts

Commands for Error Handling

FTP Client Scripting

1. 1. 

2. 2. 

3. 3. 
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2. 2. 

3. 3. 
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11.6 FTP Client Script File Format

A script file is an ASCII text file that contains a sequence of FTP (or SFTP) commands.

Each command must be on a separate line.

Space and tab characters can precede the command on a line.

Use a semicolon character (;) for comments. The FTP Client ignores comment text.

You can use comments to explain one or more lines of code. For example:

You can also add a comment at the end of a command. For example:

More information

Edit a Script

Password Security within Scripts

Commands for Error Handling

FTP Client Scripting

• • 

• • 

• • 

;The following lines connect to the server and change
;the working directories to PREPRESS (client) and
;PRESS (server).
open forum thomasp XOYRCNEL973L9L96O376ONMO770L35L7NMO87PM79
lcd c:\prepress
cd /press

set transfer-disposition unique  ;do not overwrite files
mput script is s*.doc  ;copy the .DOC files

Semicolons are not supported for comments in scripts supplied to the sftp command line using

the -B option. Use the number sign (#) to mark comments in these batch files.

note
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• • 
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11.7 Which Actions Are Captured by the Script Recorder?

Most connection and file transfer operations you perform while the script recorder is on are

recorded, but there are some exceptions: configuration options that you change via the graphical

user interface are not recorded. To include file transfer and character translation configuration

settings in a recorded script, enter SET parameters at the command line or edit the script to add 

SET parameters.

The following actions generate FTP script commands that are recorded:

You cannot record scripts when you are connected to two sites in the same session.

note
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All commands entered in the command window are recorded.

File operations you perform using the graphical user interface (GUI). See the following table

to see which FTP commands are recorded.

*  Multiple selection invokes this FTP Command multiple times.

• • 

• • 

FTP

Command

GUI Action That Generated It

OPEN Opening an FTP Site ( Open toolbar button or menu).

CLOSE Closing an FTP Site.

CD Clicking on a folder in the Site pane (or using Go to dialog box).

LCD Clicking on a folder in the Local pane.

DELETE* Deleting a file in the Site pane.

LDEL* Deleting a file in the Local pane.

RDALL* Deleting a folder in the Site pane.

LRDALL* Deleting a folder in the Local pane.

MD Creating a folder in the Site pane.

LMD Creating a folder in the Local pane.

GET* Dragging a file from the Site pane to the Local pane.

<None> Dragging a file from the Site pane to Windows Explorer, the desktop,

or a My Computer folder.

CPDIR* Dragging a folder from the Site pane to the Local pane.

<None> Dragging a folder from the Site pane to Windows Explorer, the

desktop, or a My Computer folder.

PUT* Dragging a file from the Local pane to the Site pane.

PUT* Dragging a file to the Site pane from Windows Explorer, the desktop,

or a My Computer folder.

LCPDIR* Dragging a folder from the Local pane to the Site pane.

LCPDIR* Dragging a folder to the Site pane from Windows Explorer, the

desktop, or a My Computer folder.
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More information

Command Reference

SET

Record a Script

FTP Client Scripting

If you enter an open <servername> <username> <password>  command, the 

<password> is saved as obfuscated text in the script file. For example:

If the server returns an error message when a command is entered, that error message is

recorded as a comment line in the script. For example:

note

• • 

open ftp.myco.com joe WPD6119O0O3929K148O6KN70652L0739LL00875N44O274

• • 

cd /users/bobc
; 550 /users/bobc: No such file or directory.
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11.8 Password Security within Scripts

Passwords can be included in scripts for establishing FTP (but not SFTP) connections. When you

write a script in a text editor, if the script includes a complete OPEN command ( open 

<servername> <username>

<password> ), or includes a PASSTHRU command, passwords you add manually will be visible in

the editor as plain text. For greater password security use one of these methods:

Use the Script Recorder to record the connection to the server. Passwords are stored as

obfuscated text in the script file. When the script runs and a connection is opened, the client

deciphers the password and sends it to the server.

Edit the script to remove the <password>  parameter, which is the last parameter in the 

OPEN command. The OPEN command should have the format: open <servername> 

<username> . When the script runs and a connection is opened, the client prompts the user

for a password. You may also want to omit the <username>  parameter, which causes the

client to prompt for both the user name and the password.

More information

Record a Script

Edit a Script

FTP Client Script File Format

FTP Client Scripting
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11.9 Commands for Error Handling

Include a CONTINUE command in your script file to tell the FTP Client how to handle errors that

occur when you are using wildcards to transfer files or delete local files. When CONTINUE is ON ,

file transfers or local file deletes proceed until all files satisfying the wildcard specification have

been transferred or deleted, even when an error occurs. When CONTINUE is OFF , the transfer or

delete operation aborts if an error occurs during the process; the script file terminates in response

to the error, unless ABORT-ON-ERROR is set to NO .

The ABORT-ON-ERROR parameter specifies whether execution of a script stops whenever an error

occurs in response to a command. When ABORT-ON-ERROR is set to YES , script execution will

terminate any time a command results in an error response from the FTP Client or server.

Use caution when setting ABORT-ON-ERROR to NO . Continuing command execution after an error

can yield unexpected results.

More information

Command Reference

CONTINUE

Creating Script Log Files

Handle Existing Files (Transfer Mode)
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11.10 Running a Script as a Background Task

You can create a script and configure the FTP Client so that, when the script executes, the client

runs as a background task and there is no interaction or communication with the user. To do so:

Create a shortcut with a startup command that automatically executes the script. In the Run

box, select Minimized to specify that the FTP Client should run minimized on the desktop.

Have the script connect to a site for which you already have saved the user name and

password and any passthrough settings needed to connect to that site. This prevents the

client from prompting for connection information.

Include a QUIT command to have the client shut down when the script completes.

Use the following SET parameters to control the client display of messages and prompts:

More information

Run a Script

Save your FTP Client Settings

Create a Shortcut to Connect to a Site

FTP Client Startup Switches

Run a Script File at Startup

SET

• • 

• • 
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Setting Usage

QUIET-STATUS Set to YES to suppress the connection and transfer progress

dialog boxes and the Directory Definition Wizard.

SMART-TYPE-

DEFAULT

Do not set to ASKUSER. When set to ASKUSER, the user is

prompted for a transfer method if the script transfers an

unrecognized file type.

TRANSFER-

DISPOSITION

Do not set to PROMPT. When set to PROMPT, the user is

prompted during transfer to specify handling for files that exist

at the destination.

CONFIRM-

DELETE

Set to NO to prevent the client from prompting for confirmation

prior to deleting files or folders.

RESUME-

PARTIAL-

TRANSFERS

Do not set to ASKUSER. When set to ASKUSER, the user is

prompted to choose whether to resume a partial transfer if the

FTP Client detects that a prior incomplete server file download

occurred.
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11.11 Creating Script Log Files

When you start the FTP Client with a startup command that executes a script file, you can include a

command line switch that directs the client to create a log file that stores a record of the results of

the commands that are executed.

If you want to create a log file when you execute a script file from within the client application, from

the Tools menu, choose Start Logging , and then, from the Script menu, choose Run Script .

If you are using the FTP Automation API to control the FTP Client application, you can control

logging using the StartLog and StopLog methods.

More information

FTP Client Startup Switches

Run a Script File at Startup

Options for Automating FTP Client Transfers
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12. Command Reference

12.1 Command Reference

The commands available to you for use on the command line and in scripts depend on which kind

of connection you have made.

In this section

FTP commands

SFTP commands

When you open a command topic, you can tell if it is available with FTP, SFTP, or both by looking

to see which list or lists are linked to at the top of the topic.

tip
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12.2 FTP commands

12.2 FTP commands
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12.2.1 FTP commands

You can use the commands in this list on the FTP Client command line or in a script. (If you have

made a Secure Shell SFTP connection, use the SFTP commands instead of the commands in this

list.) Use the following links to view additional command reference information.

Available commands:

12.2.1 FTP commands
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ACCOUNT

APPEND

ASCII

BINARY

CD

CHMOD

CLOSE

CONNECT

CONTINUE

CPDIR

DELETE

DIR

DISCONNECT

DISPLAY

EXIT

GET

HELP

LCD

LCPDIR

LDEL

LDIR

LMD

LRD

LRDALL

LRENAME

LS

LTYPE

MD

MDEL

MGET

MPUT

OPEN

PASSTHRU
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PUT

PWD

QUIT

QUOTE

RD

RDALL

REGET

RENAME

SET

SET Parameter Reference

SET Parameters and Equivelent Interface Settings

Site-Specific File Transfer SET Parameters

ASCII-SERVER-TYPE SET Parameter Values

NATIONAL-REPLACEMENT-SET Parameter Values

ABORT-ON-ERROR Script Sample

SITE

SMART

SYSTEM

TENEX

TYPE

VERIFY
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12.2.2 ACCOUNT

Syntax: account <accountname>

FTP Command Index

Some servers (for example, some IBM FTP servers) require the name of the account that the user

wants to access. For servers with this requirement, you cannot work with the files in that account

until you supply an account name. If you connect using an OPEN command that includes an 

<account>  parameter, the account name is not actually sent to the server unless the server

specifically prompts for an account during the login. If your server requires an account name, but

doesn't request that name during the login process, use the ACCOUNT command to explicitly tell

the server which account you want to use.

12.2.3 APPEND

Syntax: append <clientfile> [to] [<serverfile>]

FTP Command Index

The APPEND command sends a file to the FTP server, appending it to the current server file. If the

server file does not exist, this command creates it, and works exactly like the PUT command.

<accountname> Specifies an account that the logged in user has rights

to access. For case-sensitive servers, be sure to use the

appropriate case when typing the account name.

<clientfile> Specifies the PC file to transfer to the FTP server.

12.2.2 ACCOUNT

12.2.2 ACCOUNT 150



Examples

The following command appends a PC file to a server file of the same name:

This command appends a PC file to the specified server file:

12.2.4 CLOSE

Syntax: close

FTP Command Index

The CLOSE command closes the connection to the FTP server.

You can also use EXIT or QUIT as a synonym for CLOSE.

12.2.5 CONNECT

Syntax: connect [<servername>]

FTP Command Index

The CONNECTcommand initiates a connection to an FTP server. If no site is specified, a dialog box

will prompt for this information. Unlike OPEN, this command does not prompt for user name and

password. This information must be entered manually. For example, the following command

sequence would connect you to an FTP server that does not use a passthrough server (firewall):

Note that passwords appear as text on screen when you enter them directly in the command

window. Because the OPEN command prompts for passwords with dialog boxes that do not

display password text, this command is preferable for most connections. Use CONNECTif you are

troubleshooting connections through a firewall.

to 

<serverfile>

Specifies the server file to which the PC file should be appended. If this

option is omitted, the PC file is appended to a server file having the

same name as the PC file. If the specified server file does not exist, it

is created. The TO keyword is optional.

APPEND WHATSNEW.DOC

APPEND WHATSNEW.DOC TO DOCUMENT.TXT

CONNECT <server>
USER <username>
PASS <password>
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12.2.6 CONTINUE

Syntax: continue [on | off]

FTP Command Index

The CONTINUE command instructs Reflection FTP to ignore errors that occur during a wildcard file

transfer initiated at the FTP command line. File transfer proceed as though no error occurred, until

all files satisfying the wildcard specification have been transferred.

CONTINUE with no arguments tells Reflection FTP to ignore an error in the next MGET or MPUT

command only.

The CONTINUE command only applies to the series of commands that comprise an MGET or 

MPUT block (such as LIST, GET, PUT, CD). If an error is encountered in any of the commands in the

series, the script will stop after it finishes the complete MGET or MPUT command series. To allow

the script to process further commands, change SET-ABORT-ON-ERROR to NO.

The CONTINUE command does not apply to drag-and-drop file operations.

Example

This sequence of commands instructs Reflection FTP to ignore any error in the next MPUT

command. Without CONTINUE, the MPUT command aborts if an error occurs during the transfer.

See ABORT_ON_ERROR Script Sample for an additional example.

12.2.7 CPDIR

Syntax: cpdir <server directory> [<pc-path>] [askuser | cancel | overwrite | skip]

FTP Command Index

The CPDIRcommand copies the specified server directory to the PC. If a PC directory is not

specified, the server directory is copied to the current PC path.

on Tells Reflection to ignore all file transfer errors, as if every subsequent MGET

and MPUT command were preceded by a CONTINUE.

off Reverses the ON option.

CONTINUE
MPUT ACCT*.TXT

server directory Specifies the name of the server directory.
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pc-path Specifies the PC drive and folder.
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12.2.8 DELETE

Syntax: delete <serverfile>

FTP Command Index

The DELETE command deletes a file matching the given filespec on the FTP server.

Examples

This command deletes MEMO.DOC from the current server directory:

The next command deletes the budget.new file from the /users/jill jones directory on a UNIX FTP

server:

askuser | cancel | 

overwrite | skip

Specifies what to do if the target folder already exists.

ASKUSER is the default.

If the SET parameter CONFIRM-DELETE is set to YES, the user is prompted for confirmation

before deleting.

note

<serverfile> Specifies the name of a server file to delete. This can include a full

directory path to the file. On some systems such as UNIX FTP servers,

case is important when specifying directories and file names.

DELETE MEMO.DOC

DELETE /users/jill jones/budget.new
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12.2.9 DIR

Syntax: dir [<server filespec>]

FTP Command Index

The DIR command displays a detailed listing of server files matching the given file specification.

(Compare this to the LS command, which displays a less detailed listing.)

Example

This command displays a list of executable files in the current directory on a VAX/VMS FTP server:

12.2.10 DISCONNECT

Syntax: disconnect

FTP Command Index

The DISCONNECT command closes the connection to the FTP server.

You can also use CLOSE, EXIT, or QUIT as a synonym for DISCONNECT.

<server 

filespec>

Specifies a directory, file, or group of files on the FTP server. If this option

is not used, the contents of the current server directory are displayed.

The syntax for <server filespec>  varies according to your FTP server.

DIR *.EXE
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12.2.11 DISPLAY

Syntax: display <string>

FTP Command Index

The DISPLAY command displays data in the command window as if it had been received from the

FTP server.

Example

You can use the DISPLAY command to do such things as display a message or reminder about the

current process. For example, the following command displays a message that a logon process

occurs next:

12.2.12 HELP

Syntax: help [<command>]

FTP Command Index

HELP displays a short summary of FTP commands. You can type HELP

<command>  at the FTP command line to see information on a specific FTP command. For a listing

of FTP commands without descriptions, enter HELP at the command line.

With many FTP servers, you can enter QUOTE HELP  at the command line for a list of commands the

server recognizes. Entering QUOTE HELP

<command>  sometimes gives more detailed information about the command. See QUOTE for more

information.

<string> The <string>  parameter can be any string of characters.

The character string displays on a single line. If the specified character

string exceeds the width of the Reflection FTP window, characters at the

end of the string will be hidden; the string will not wrap to the next line. For

example, if the window is sized to 50 columns wide and the <string>  is 60

characters long, the last 10 characters of the string will be hidden.

DISPLAY Next process is logon to bigben.timer.london

HELP displays the FTP command list even if you have made an SFTP connection. Click here for

a list of commands available during SFTP sessions.

note
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12.2.13 LCPDIR

Syntax: lcpdir <pc drive/folder> [<server folder>] [askuser | cancel | overwrite | 

skip]

FTP Command Index

The LCPDIR command copies the specified PC folder to the server. If a server folder is not

specified, the PC folder is copied to the current server path.

pc drive/folder Specifies the local folder. Use quotation marks if the file or

path includes spaces. For example: lcpdir "d:\Asian 

Travel\China"

<server folder> Specifies the server folder.
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12.2.14 LDEL

Syntax: ldel <pc filespec>

FTP Command Index

The LDELcommand deletes the specified file on the PC. Wildcards are not supported.

Example

This command deletes Map.bmp from the France folder within the European Travel folder on the

PC:

askuser | cancel | 

overwrite | skip

Specifies what to do if the target folder on the server already

exists. ASKUSER is the default.

If the SET parameter CONFIRM-DELETE is set to YES, the user is prompted for confirmation

before deleting.

note

<pc 

filespec>

Specifies the name of a PC file to delete. The filespec can include a full

directory path to the file.

LDEL \European Travel\France\map.bmp
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12.2.15 LDIR

Syntax: ldir [<pc filespec>]

FTP Command Index

The LDIR command displays a listing of PC files matching the given filespec.

Example

This command displays a listing of all the files in the specified PC folder that have the name Old

Data and end with any extension:

12.2.16 LMD

Syntax: lmd <pc directory>

FTP Command Index

The LMDcommand creates a folder on the PC.

Example

This command creates the folder Music on the current PC drive:

<pc 

filespec>

Specifies a folder, a file, or a group of files on the PC. If this option is not

used, the contents of the current PC folder are displayed.

LDIR D:\Results\Old Data.*

<pc 

folder>

Specifies the drive where you want to create the folder (if other than the

current drive) and the folder name.

LMD \Music
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12.2.17 LRD

Syntax: lrd <pc directory>

FTP Command Index

The LRD command deletes a PC folder and all the files and folders it contains.

You can also use LRDALL as a synonym for LRD.

Example

This command deletes the folder "Trial Dates" from within the "Cases" folder on the J drive:

If the SET parameter CONFIRM-DELETE is set to YES, the user is prompted for confirmation

before deleting.

note

<pc 

folder>

Specifies the location and name of the folder you want to delete. The 

<folder>  specification must follow PC conventions

LRD J:\Cases\Trial Dates
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12.2.18 LRDALL

Syntax: lrdall <pc folder>

FTP Command Index

The LRDALLcommand deletes a PC folder and all the files and folders it contains.

You can also use LRD as a synonym for LRDALL.

Example

This command deletes the folder "Trial Dates" from within the "Cases" folder on the J drive:

12.2.19 LRENAME

Syntax: lrename <pc filename> <new filename>

FTP Command Index

The LRENAME command changes the name of a local file to the new name specified.

If the SET parameter CONFIRM-DELETE is set to YES, the user is prompted for confirmation

before deleting.

note

<pc folder> Specifies the location and name of the folder you want to delete.

LRD J:\Cases\Trial Dates

<pc 

filename>

Specifies the name of the PC file you want to rename. The specification

can include the PC drive and folder where the file is located. If the file

location or name contains spaces, the specification must be enclosed

with quotation marks. For example: "D:\To do\Monthly tasks" .
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Example

From the current folder on the C drive , this command renames a file in the folder "Archive" on the D

drive, changing the name from "Stories.txt" to "Fairy tales":

12.2.20 LTYPE

Syntax: ltype <clientfile>

FTP Command Index

The LTYPE command displays the contents of a PC file in the FTP command window.

Example

The following command displays the content of the file Com.doc in the Subjects folder on the J

drive on the PC:

<new 

filename>

Specifies the name you want to give the file. If the file to be renamed does

not exist on the active local drive and folder, you must include the location

in the <new filename>  specification. Use quotation marks if the file or

path includes spaces. For example, "D:\To do\Work assignments" .

LRENAME D:\Archive\Stories.txt "D:\Archive\Fairy tales"

<clientfile> Specifies the location and name of the PC file. This specification cannot

contain wildcards.

LTYPE J:\Subjects\Com.doc
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12.2.21 MD

Syntax: md <server folder>

FTP Command Index

The MD command creates a folder on the server.

Example

This command creates the folder Films within the current folder on the current FTP UNIX server

drive:

<server folder> Specifies the name and location of the new folder.

MD Films
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12.2.22 MDEL

Syntax: mdel <server filespec>

The MDEL command deletes one or more files matching the given filespec on the FTP server.

MDELdiffers from DELETE in that MDELsupports multiple file deletions from the server using server

wildcard characters. Your FTP server must support wildcards for multiple file deletions.

Examples

This command deletes all files from the current server directory:

This command deletes all files ending with ".htm" from the current server directory:

See ABORT_ON_ERROR Script Sample for an example.

If the SET parameter CONFIRM-DELETE is set to YES, the user is prompted for confirmation

before deleting.

note

<server 

filespec>

Specifies one server file or (using server wildcards) multiple server files.

This can include a full directory path to the file. On some systems such

as UNIX FTP servers, case is important when specifying directories and

file names.

MDEL *

MDEL *.htm
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12.2.23 OPEN

Syntax: open [<servername> [<username> [<password> [<account>]]]]

FTP Command Index

The OPEN command connects to the FTP server and attempts to log in using the server name,

username, and password specified. For case-sensitive servers, be sure to use the appropriate case

when typing parameter values. If no parameters are specified with the OPEN command, the user is

prompted for login information.

When only one parameter is present, it must be <servername> . If you add a second parameter it

must be <username> . If you use three parameters, the third must be <password> .

If you use a passthrough server to log into FTP servers, use the PASSTHRU command to open a

server connection.

note

<servername> Specifies a server. This can be an IP address, a URL, or

a name from a Hosts file.

<username> Specifies a valid username registered on the current

FTP server. When opening an anonymous connection,

the username is usually "anonymous."

<password> Specifies the password assigned to user <username> .

Most anonymous FTP servers expect you to supply your

e-mail address as the password.
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Examples

This command opens an anonymous connection to the FTP server, supplying an e-mail address for

the password:

The following command opens a connection to the Headquarters FTP server for user Jackie. A

password parameter wasn't specified, so the user will be prompted to enter a password during the

login process.

<account> Specifies an account that user <username>  has rights

to access. Typically, anonymous FTP servers do not

request an account, so this parameter can be omitted.

When an OPEN command that includes an <account>

parameter is executed, the account name is not sent to

the server unless the server specifically prompts for an

account during the login. If your server requires an

account name, but doesn't request that name during the

login process, use the ACCOUNT command to explicitly

tell the server which account you want to use.

OPEN ftp.acme.com anonymous jackie@mycompany.com

OPEN Headquarters Jackie
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12.2.24 PASSTHRU

Syntax 1: passthru <passthrough servername> <username>@<servername> <password>

Syntax 2: passthru <passthrough servername> <passthrough username> <passthrough 

password> <username>@<servername> <password>

Syntax 3: passthru <passthrough servername> <passthrough username> <passthrough 

password> <servername> <username> <password>

FTP Command Index

The PASSTHRU command opens a connection to the FTP server using the passthrough server

specified. Two styles of passthrough servers are supported. Reflection FTP sends different

commands to log into the passthrough server and connect to an FTP server, based on the 

PASSTHRU syntax you specify.

When using any form of the PASSTHRU command, all parameters are required. If you specify "" (a

null value) for a parameter, the FTP Client displays a dialog box prompting for that value. For case-

sensitive servers, be sure to use the appropriate case when typing parameter values.

SYNTAX 1

Use this type of PASSTHRU command if your passthrough server is a username@servername  style

server that does not require a passthrough password (that is, it does not perform authentication).

This form of the PASSTHRU command sends the current FTP server user name and server name in

the format username@servername  to the passthrough server specified in <passthrough 

servername> . The passthrough server uses this information to open a connection to the specified

FTP server.

If the FTP server you connect to with the PASSTHRU command requires an account name, use

the ACCOUNT command to tell the FTP server which account you want to use.

note

<passthrough servername> Specifies a connection name for the passthrough

server. If you want the FTP Client to prompt for the

passthrough servername, specify "" (a null value) for

this parameter.
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<username>@<servername> The <username>  portion of the argument specifies a

valid user name registered on the FTP server.

The <servername>  portion of the argument specifies a

connection name for the FTP server.
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SYNTAX 2

Use this type of PASSTHRU command if your username@servername  style passthrough server is

set up to authenticate the user on the passthrough server prior to opening a connection to an FTP

server.

This form of the PASSTHRU command allows you to log into a <username@servername>  style

passthrough server that will open the connection to the FTP server. The command logs into the

passthrough server specified in <passthrough servername> . The login command provides the

username and the password on the passthrough server, based on <passthrough username>  and 

<passthrough password> . Once the user is authenticated on the passthrough server, the FTP 

<username>  and FTP <servername>  are sent to the passthrough server. This information is

specified in the format: username@servername . The passthrough server uses this information plus

the FTP server <password>  to open a connection to the FTP server.

SYNTAX 3

This form of the PASSTHRU command allows you to log into a SITE servername style passthrough

server that will open the connection to the FTP server.

Reflection FTP sends a command to log into the passthrough server specified in <passthrough 

servername> . The login command provides the username and the password on the passthrough

server, based on <passthrough username>  and <passthrough password> . Once a connection is

opened, a site command is sent to the passthrough server, passing the settings needed to connect

to the FTP server ( <servername> , <username> , and <password> ). The passthrough server uses

this information to open a connection to the FTP server.

<password> Specifies the password assigned to user 

<username> on the FTP server. If you want the FTP

Client to prompt for the user password, specify "" (a null

value) for the password.
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12.2.25 QUOTE

Syntax: quote <string>

FTP Command Index

The QUOTE command sends a string to the FTP server. Use QUOTE to issue commands to the FTP

server that are not implemented by the Reflection FTP Client.

With many FTP servers, you can type QUOTE HELP  for a list of commands the server recognizes.

Typing QUOTE HELP <command>  sometimes gives more detailed information about the command.

Example

To create the subdirectory FIFE on a VAX/VMS FTP server, you could use this command:

12.2.26 RD

Syntax: rd <server folder>

FTP Command Index

The RD command deletes an empty folder on the server.

Example

This command deletes the folder Articles from the current server folder:

<string> Specifies the string to send to the server. Valid strings you can use with the

QUOTE command depend entirely on the FTP server; check your server

documentation for details.

QUOTE MKD MAYBERRY$USERS:[BARNEY.FIFE]

If the SET parameter CONFIRM-DELETE is set to YES, the user is prompted for confirmation

before deleting.

note

<server 

folder>

Specifies the location and name of the folder you want to delete. Before

you can delete a folder, you must delete the files and folders within it.

RD Articles
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12.2.27 RDALL

RDALL

Syntax: rdall <server folder>

FTP Command Index

The RDALL command deletes a folder and all the files and folders within it on the server.

Examples

This command deletes the directory Maps from the current server location:

This command deletes the folder "Destinations" from the "Travel/Europe" folder:

If the SET parameter CONFIRM-DELETE is set to YES, the user is prompted for confirmation

before deleting.

note

<server 

directory>

Specifies the location and name of the directory you want to delete. On

some systems such as UNIX FTP servers, case is important when

specifying directories.

RDALL Maps

RDALL /Travel/Europe/Destinations
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12.2.28 REGET

Syntax: reget <serverfile> [to] [<clientfile>]

FTP Command Index

The REGET command directs the FTP Client to automatically resume an incomplete file transfer

from the FTP server to the PC. The Client automatically completes the file transfer from the point at

which the download was interrupted.

If the Client does not find a partial file locally, it performs a GET to do a complete transfer of the

specified server file. If the local folder already contains a file with the same name as the file being

transferred, the local file is overwritten.

The REGET command works only for BINARY file transfers. Before using the REGET command, if

necessary, use the BINARY command to override the default file transfer method setting specified

on the Tools menu.

Note

<serverfile> Specifies the name of the server file to transfer to the PC.
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12.2.29 SET

SET Parameter Reference

The following parameters are for use with the SET command. Settings are site-specific unless

otherwise stated.

to 

<clientfile>

Specifies the name of the PC file to be created.

For most REGET operations, you can omit this option. When this option

is omitted, the client file receives the same name as the server file.

If the interrupted file transfer specified that the downloaded file be

given a new name on the PC, be sure to use that name as the 

<clientfile>  specification. This ensures that the Client can find the

partial local file and successfully resume the transfer. 

The TO keyword is optional.

SET Parameter Values Description

ABORT-ON-ERROR YES | NO 

(Default: YES)

Specifies whether execution of a script

stops whenever an error occurs in

response to a command. See 

ABORT_ON_ERROR Script Sample for an

example.

ACCOUNT <string>  (there is

no default value)

Specifies the name of the account to log

into on an FTP server. This setting does

not apply to SFTP connections.

ANONYMOUS YES | NO 

(Default: NO)

When set to YES, the client performs an

anonymous login, using the user name

"anonymous."
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SET Parameter Values Description

ASCII-CLIENT-

TYPE

<value>  (Default:

WINDOWS)

When TRANSLATE-FILES and/or

TRANSLATE-DIRECTORY-LISTING is YES,

specifies the character set to use on the

client PC during ASCII file transfers.

Possible values are: PC-ENGLISH (IBM

PC extended characters), PC-SLAVIC

(DOS 852 code page), WINDOWS,

WINDOWS-ANSI, WINDOWS-LATIN-2,

WINDOWS-CYRILLIC, WINDOWS-GREEK,

YUASCII. This setting does not apply to

SFTP connections.

ASCII-SERVER-

TYPE

<value>  (Default:

DEC Supplemental)

When TRANSLATE-FILES and/or

TRANSLATE-DIRECTORY-LISTING is YES,

specifies the FTP server character set to

use during ASCII file transfers. Possible

values. This setting does not apply to

SFTP connections.

AUTO-SERVER-

UPDATE

YES | NO 

(Default: YES)

This global parameter specifies whether

the server directory listing shown in the

right pane is updated when you perform

any operation that adds or deletes files

or directories on the server.

CLIENT-HOME-

DIRECTORY

<string> Specifies the path to a home (default)

directory for the local PC. If this setting

is not set, the global Default local home

directory setting is used.

CONFIRM-DELETE YES | NO 

(Default: YES)

This global parameter specifies whether

the client should prompt for

confirmation before deleting a file.

CREATE-SERVER-

UPPER

YES | NO 

(Default: NO)

Specifies whether all files transferred to

the server are given uppercase file

names.

CREATE-8.3-

FILENAMES

YES | NO 

(Default: NO)

Specifies whether files transferred to the

client use the 8.3 file naming convention.
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SET Parameter Values Description

CTRL-Z-EOF YES | NO 

(Default: NO)

Applies to ASCII file transfers to a server.

When this parameter is set to YES, file

transfer uses Ctrl-Z as the end-of-file

marker and strips it from the file being

sent. When set to NO; the character

count in the file directory entry is used to

determine the file length. This setting

does not apply to SFTP connections.

DELETE-

TRAILING-SPACES

YES | NO 

(Default: NO)

Specifies whether to delete trailing

spaces during ASCII file transfers from

the server. This setting does not apply to

SFTP connections.

EMAIL-ADDRESS <string>  (there is

no default value)

This global parameter specifies your

Internet email address. When opening a

connection, most anonymous FTP sites

ask you to supply your email address,

which is used as the password for your

guest login. Anonymous connections are

not available for SFTP sessions.

FULL-TO-HALF-

FROM- SERVER

YES | NO 

(Default: NO)

Applies to ASCII file transfers from the

server. If you want messages and files

with DEC Kanji or JIS Kanji characters to

be converted from full- to half-width

Katakana when received from the server,

set this value to YES. The ASCII-SERVER-

TYPE parameter determines which Kanji

character set is used during the

conversion.

HALF-TO-FULL-

TO-SERVER

YES | NO 

(Default: NO)

Applies to ASCII file transfers to the

server. If you want files with DEC Kanji or

JIS Kanji characters to be converted

from half- to full-width Katakana when

sent to the server, set this value to YES.

The ASCII-SERVER-TYPE parameter

determines which Kanji character set is

used during the conversion.
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SET Parameter Values Description

ISO7-TO-ROMAN8 YES | NO 

(Default: NO

Applies to ASCII file transfers from the

server when TRANSLATE-FILES is YES. If

you want files with ISO-7 characters to

be converted to files with Roman 8

characters when received on the PC, set

this value to YES. The NATIONAL-

REPLACEMENT-SET parameter

determines the character conversion.

KANJI-AUTO-

DETECT

YES | NO 

(Default: NO)

Specifies whether the client should

automatically try to detect the type of

Kanji character set (JIS, EUC, or DEC)

used in any ASCII file and or message

received from the server and then use

the detected Kanji set for character

translations.

MCS-TO-NRC YES | NO 

(Default: NO)

Determines character set translation

during ASCII file transfers to the server

when TRANSLATE-FILES is YES. When

set to YES, characters are translated

from the DEC Multinational character set

to the current national replacement

character set. The NATIONAL-

REPLACEMENT-SET value determines

the character conversion.

NATIONAL-

REPLACEMENT-

SET

<value>  (Default:

USASCII)

Relevant when TRANSLATE-FILES and/

or TRANSLATE-DIRECTORY-LISTING is

YES. If necessary, set this parameter to

match the set used by your host.

Character translations occur between

the client and the server when a PC file

is sent to the server, and when

characters sent from the server are

written to local files, to the screen, or

both. Possible values. This setting does

not apply to SFTP connections.
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SET Parameter Values Description

NRC-TO-MCS YES | NO 

(Default: NO)

Determines character set translation

during ASCII file transfers from the FTP

server to the PC when TRANSLATE-

FILES and/or TRANSLATE-DIRECTORY-

LISTING is YES. When set to YES,

characters are translated from the

current national replacement character

set to the DEC Multinational Character

set. The NATIONAL-REPLACEMENT-SET

value determines the character

conversion. This setting does not apply

to SFTP connections.

PASSIVE YES | NO 

(Default: YES)

Specifies whether the client will send a

PASV command to communicate with

the server in passive mode (sometimes

called PASV mode). Setting PASSIVE to

YES causes the FTP Client to initiate a

separate data connection for directory

listings and file transfers. Passive mode

is required for connections through

some firewalls. This setting does not

apply to SFTP connections.

PASSTHROUGH-

AUTHENTICATION

YES | NO 

(Default: NO)

You must be connected to a site to

change this global passthrough server

property. Set PASSTHROUGH-

AUTHENTICATION to YES if your

passthrough server requires you to

provide a user name and password to

log into the passthrough server. This

setting is ignored if USE-

PASSTHROUGH-SERVER is set to NO or

if PASSTHROUGH-SERVER-STYLE is set

to SITE-SERVERNAME.
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SET Parameter Values Description

PASSTHROUGH-

PASSWORD

<string>  (there is

no default value)

You must be connected to a site to

change this global passthrough server

property. This setting specifies your

password on the passthrough server on

your local network. For case-sensitive

servers, you must use the appropriate

case when you enter this value.

PASSTHROUGH-

SERVER-STYLE

<value>  (Default:

SITE-

SERVERNAME)

You must be connected to a site to

change this global passthrough server

property. The FTP Client sends different

commands to log into the passthrough

server and connect to an FTP server,

based on the style of server you specify.

PASSTHROUGH-

SERVERNAME

<string>  (there is

no default value)

You must be connected to a site to

change this global passthrough server

property. This setting specifies the name

of the passthrough server on the local

network that you use to log on to an FTP

server.

PASSTHROUGH-

USERNAME

<string>  (there is

no default value)

You must be connected to a site to

change this global passthrough server

property. Use this setting to specify a

valid user name registered on the

passthrough server for your local

network. For case-sensitive servers, you

must use the appropriate case when

entering the PASSTHROUGH-USERNAME

value.

PASSWORD <string>  (there is

no default value)

Specifies your password on the current

FTP server.

PORT-NUMBER 0 - 65535 (Default:

0)

Specifies a non-standard TCP service

port number or socket for FTP. The

default value 0 (zero) directs the FTP

Client to use the standard service port

for FTP, which is 21. This setting does

not apply to SFTP connections.

12.2.29 SET

12.2.29 SET 178



SET Parameter Values Description

PRESERVE-FILE-

DATE

YES | NO 

(Default: NO)

Specifies whether files that are

downloaded from the server should

retain the original date stamps

associated with the files. If you want

files transferred from the server to be

date stamped with the time and date

when they were transferred, set this

parameter to NO.

PROXY-SERVER <value> This is a read-only parameter that

indicates whether the FTP Client

connects to this site using a

passthrough server or SOCKS proxy

server. The possible values are PROXY

SERVER and SOCKS PROXY.

QUIET-STATUS YES | NO 

(Default: NO)

This global parameter suppresses dialog

box display, including Connection

progress, Transfer progress, and Error

notification.

RESUME-PARTIAL-

TRANSFERS

ALWAYS | NEVER | 

ASKUSER 

(Default: 

ASKUSER)

This session-specific parameter is

relevant for downloading files from the

server in BINARY format. When you GET

a server file, the FTP Client detects

whether a prior incomplete download

operation occurred for that file. This

parameter allows you to control whether

the Client prompts for input when it

detects that a prior partial download

occurred. Auto resume compares the

size of the source file to the size of the

incomplete target file to determine at

what point in the source file it should

resume the transfer. Using the binary

method ensures that the file created on

the local machine matches the size of

the source file.
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SET Parameter Values Description

ROMAN8-TO-ISO7 YES | NO 

(Default: NO)

Applies to ASCII file transfers to the

server when TRANSLATE-FILES is YES. If

you want files with Roman 8 characters

to be converted to files with ISO-7

characters when transferred to the

server, set this value to YES. This setting

does not apply to SFTP connections.

SAVE-PASSWORD YES | NO 

(Default: NO)

Specifies whether the site password is

saved.

SAVE-

PASSTHROUGH-

PASSWORD

YES | NO 

(Default: NO)

You must be connected to a site to

change this global passthrough server

property. When set to NO, the

passthrough password is not saved.

SERVER-HOME-

DIRECTORY

<string> Specifies the path to a home (default)

directory for the FTP or SFTP site to

which you are currently connected.

When a connection to the FTP or SFTP

site is opened, the server working

directory is set automatically to the

specified home path. If no value is

specified, the user home directory is

used.

SERVERNAME <string>  (there is

no default value)

Specifies the name of the server that you

want to log into. The server name is

resolved via the Hosts file or a domain

name server. If you have no domain

name server on the local network and

don't use a Hosts file, you must specify

the full IP address. The value you specify

is used the next time you open a

connection during the current session.
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SET Parameter Values Description

SMART-ASCII-

TYPES

(DEFAULT:

txt,bat,htm,html,ini)

This global parameter specifies all the

file extensions used to identify files that

should be transferred using the ASCII

transfer method when TRANSFER-

METHOD is set to SMART. To specify a

list of file extensions, separate each

extension with a comma. For example: 

SET SMART-ASCII-TYPES 

txt,bat,htm,html,ini

SMART-BINARY-

TYPES

<string>

(DEFAULT:

exe,gif,jpg,wav)

This global parameter specifies all the

file extensions used to identify files that

should be transferred using the Binary

transfer method when TRANSFER-

METHOD is set to SMART. To specify a

list of file extensions, separate each

extension with a comma. For example: 

SET SMART-BINARY-TYPES 

exe,gif,jpg,wav

SMART-TENEX-

TYPES

<string>  (there is

no default value)

This global parameter specifies all the

file extensions used to identify files that

should be transferred using the Tenex

(Local 8) transfer method when

TRANSFER-METHOD is set to SMART. To

specify a list of file extensions, separate

each extension with a comma. For

example: SET SMART-TENEX-TYPES 

edd,gol,mmd,lad

SMART-TYPE-

DEFAULT

ASCII | BINARY | 

TENEX | ASK USER 

(Default: ASK 

USER

This global parameter specifies a default

transfer method to use when TRANSFER-

METHOD is set to SMART and the

source file has an extension that has not

been defined as either SMART-ASCII-

TYPE, SMART-BINARY-TYPE, or SMART-

TENEX-TYPE. During file transfers, if the

source file uses an extension that has

not been associated with a file transfer

method, Smart File Transfer uses the

transfer method specified for SMART-

TYPE-DEFAULT.
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SET Parameter Values Description

SPACES-PER-TAB 1-20 (Default: 8) Applies to ASCII file transfers. Specifies

the number of consecutive spaces that

are converted to a single tab character

(for SPACES-TO-TABS) or the number of

spaces that a single tab character is

converted into (for TABS-TO-SPACES).

This setting does not apply to SFTP

connections.

SPACES-TO- TABS YES | NO 

(Default: NO)

Applies to ASCII file transfers from the

host. When receiving ASCII files, you can

replace consecutive spaces with tabs by

setting this parameter to YES. The

number of spaces that are converted to

a single tab is controlled by the SPACES-

PER-TAB parameter. This setting does

not apply to SFTP connections.

TABS-TO- SPACES YES | NO 

(Default: YES)

When set to YES, tab characters in local

files are converted to space characters

in server files during ASCII transfers to

the server. The FTP Client replaces each

tab character with the number of spaces

necessary to fill out to the next tab stop,

as specified by the SPACES-PER-TAB

parameter. This setting does not apply to

SFTP connections.

TIME-LOGGED-IN (Read-only) This is a read-only parameter that

indicates the time when you logged into

the server. The current time format

specified in the International dialog box

in the Windows Control Panel

determines how time data displays.

TIME-SINCE-

LOGIN

(Read-only) This is a read-only parameter that

indicates how long you have been

logged into the server. The current time

format specified in the International

dialog box in the Windows Control Panel

determines how time data displays.
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SET Parameter Values Description

TIMEOUT-

CONNECT

0 - 65535 (Default:

120)

Specifies how long (in seconds) the

client should continue trying to establish

a server connection before it gives up.

Setting this parameter to 0 (zero)

prevents the FTP Client from ever timing

out on a connection attempt. This

setting does not apply to SFTP

connections.

TIMEOUT-

SESSION

0 - 65535 (Default:

120)

Specifies the maximum number of

seconds to wait for data packets being

transferred to or from the host. If nothing

is received within the period specified, a

timeout error displays and the transfer is

aborted. Setting this parameter to 0

(zero) prevents the FTP Client from ever

timing out when waiting for a response.

This setting does not apply to SFTP

connections.

TRANSFER-8.3-

CASE

LOWER | UPPER | 

PRESERVE 

(Default: LOWER)

Specifies how case is handled in the

names of files sent to the host, when the

source file name conforms to the DOS

8.3 file naming convention. This setting

is ignored when CREATE-SERVER-UPPER

is set to yes.

TRANSFER-

DISPOSITION

<value>  (Default:

OVERWRITE)

This global parameter specifies a file

transfer mode that tells the client what

to do if the client or server file being

transferred already exists at the

destination. The possible values are

APPEND, PROMPT, CANCEL,

OVERWRITE, SKIP, UPDATE, UNIQUE.

UPDATE directs the client to overwrite

the destination file only if the file being

transferred is newer than the destination

file. UNIQUE directs the client to create a

new unique name.
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SET Parameter Values Description

TRANSFER-

ELAPSED-TIME

(Read-only) This is a read-only parameter that

indicates how long the last completed

file transfer took to complete. The

current time format specified in the

International dialog box in the Windows

Control Panel determines how time data

displays.

TRANSFER-

METHOD

<value>  (Default:

SMART)

This global parameter specifies the file

transfer method for the client. The

possible values are ASCII, BINARY,

TENEX, SMART.

TRANSFER- SPEED (Read-only) This is a read-only parameter that

indicates the speed of the last

completed file transfer. This value

represents the number of kilobytes

transferred per second.

TRANSLATE-

DIRECTORY-

LISTING

YES | NO 

(Default: NO)

Specifies whether to enable translation

when characters sent from the server

are written to the screen. Use this setting

to translate file names in server directory

listings that display in the FTP Client

user interface. Setting this parameter to

YES enables the following SET

parameters: SET ASCII-CLIENT-TYPE,

SET ASCII-SERVER-TYPE, SET

NATIONAL-REPLACEMENT, ISO7-TO-

ROMAN8, and SET NRC-TO-MCS. This

setting does not apply to SFTP

connections.
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SET Parameter Values Description

TRANSLATE-

FILES

YES | NO 

(Default: NO)

Specifies whether to enable translation

of ASCII files. When set to YES, character

translations occur between the client

and the server when a PC file is sent to

the server, and when characters sent

from the server are written to a client

file. Setting this parameter to YES

enables the following SET parameters:

SET ASCII-CLIENT-TYPE, SET ASCII-

SERVER-TYPE, SET NATIONAL-

REPLACEMENT, SET ISO7-TO-ROMAN8,

SET ROMAN8-TO-ISO7, SET NRC-TO-

MCS, and SET MCS-TO-NRC. This setting

does not apply to SFTP connections.

USE-

PASSTHROUGH-

SERVER

YES | NO 

(Default: NO)

Specifies whether to connect through a

passthrough server when opening

connections to the current FTP site.

When set to YES, the FTP Client uses the

following global settings to make the

connection to the passthrough server:

PASSTHROUGH-SERVER-STYLE,

PASSTHROUGH-SERVERNAME,

PASSTHROUGH-USERNAME,

PASSTHROUGH-PASSWORD, and

PASSTHROUGH-AUTHENTICATION.

USE-SOCKS YES | NO 

(Default: NO)

Specifies whether you want to use a

SOCKS proxy server for connections

made to the current site. When set to

YES, the FTP Client uses a SOCKS proxy

server.

USERNAME <string>  (there is

no default value)

Specifies a valid user name registered

on the current server. For case-sensitive

servers, you must use the appropriate

case when entering the USERNAME

value.
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SET Parameters and Equivalent Interface Settings

SET parameters are for use with the SET command. This table lists equivalent settings in the FTP

Client user interface.

SET Parameter Values Description

WRITE-CTRLZ YES | NO 

(Default: NO)

Applies to ASCII file transfers from the

server. When set to YES, the FTP Client

automatically adds an end-of-file marker

(^Z) at the end of a received ASCII file.

SET Parameter Equivalent Interface Setting

ABORT-ON-ERROR No equivalent dialog box setting

ACCOUNT Account box on Connection tab in Site

Properties dialog box

ANONYMOUS Anonymous option on General tab in Site

Properties dialog box

ASCII-CLIENT-TYPE Client character set in Character Sets

dialog box

ASCII-SERVER-TYPE Server character set in Character Sets

dialog box

AUTO-SERVER- UPDATE Refresh directory automatically check

box on the Directories tab in the Site

Properties dialog box

CLIENT-HOME- DIRECTORY Local Home folder box on the Directories

tab in the Site Properties dialog box

CONFIRM-DELETE Confirm file delete check box on the 

Preferences tab in the Options dialog

box

CREATE-SERVER- UPPER Set case of 8.3 file names list box on the

Transfer tab in the Site Properties dialog

box

CREATE-8.3- FILENAMES Create Windows file names in 8.3 format

check box on the Transfer tab in the Site

Properties dialog box

12.2.29 SET

12.2.29 SET 186



SET Parameter Equivalent Interface Setting

CTRL-Z-EOF Read Ctrl-Z as end of file under To

server in the Translation tab in the Site

Properties dialog box

DELETE-TRAILING- SPACES Delete trailing spaces check box on the 

Translation tab in the Site Properties

dialog box

EMAIL-ADDRESS Anonymous password box on the 

General tab in the Options dialog box

FULL-TO-HALF-FROM- SERVER Full- to half-width Katakana check box in

Character Sets dialog box

HALF-TO-FULL-TO- SERVER Half- to full-width Katakana check box in

Character Sets dialog box

ISO7-TO-ROMAN8 Change ISO-7 to Roman-8 check box in 

Character Sets dialog box

KANJI-AUTO-DETECT Detect server Kanji type check box in 

Character Sets dialog box

MCS-TO-NRC Change MCS to NRC check box in 

Character Sets dialog box

NATIONAL-REPLACEMENT-SET ISO-7/NRC set in Character Sets dialog

box

NRC-TO-MCS Change NRC to MCS check box in 

Character Sets dialog box

PASSIVE Use passive mode check box on 

Connection tab in the Site Properties

dialog box

PASSTHROUGH- AUTHENTICATION Use Firewall check box on the Firewall

tab in the Security Properties dialog box

PASSTHROUGH- SERVERNAME Server name box on the Firewall tab in

the Security Properties dialog box

PASSTHROUGH- USERNAME User name box on the Firewall tab in the 

Security Properties dialog box
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SET Parameter Equivalent Interface Setting

PASSWORD Password box on General tab in the Site

Properties dialog box

PORT-NUMBER TCP port box on Connection tab in the 

Site Properties dialog box

PRESERVE-FILE- DATE Preserve server file date check box on

the Transfer tab in the Site Properties

dialog box.

PROXY-SERVER Read-only value based firewall and

SOCKS configuration in the Security

Properties dialog box.

QUIET-STATUS Hide progress window check box on the 

Preferences tab in the Options dialog

box

ROMAN8-TO-ISO7 Change Roman-8 to ISO-7 check box in

the Character Sets dialog box

SAVE-PASSWORD Save password check box on the General

tab in the Site Properties dialog box

SAVE-PASSTHROUGH- PASSWORD Save password check box on the Firewall

tab in the Security Properties dialog box

SERVER-HOME-

DIRECTORY_SERVER_HOME_DIRECTORY

Server Home directory box on the 

Directories tab in the Site Properties

dialog box

SERVERNAME_SERVERNAME FTP address box on the General tab in

the Site Properties dialog box

SMART-ASCII-TYPES File transfer types on the File Types tab

in the Options dialog box

SMART-BINARY-TYPES File transfer types on the File Types tab

in the Options dialog box

SMART-TENEX-TYPES File transfer types on the File Types tab

in the Options dialog box

SMART-TYPE-DEFAULT Transfer method for undefined file types

group box on the File Types tab in the 

Options dialog box
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SET Parameter Equivalent Interface Setting

SPACES-PER-TAB Spaces per tab box on Translation tab in

the Site Properties dialog box

SPACES-TO-TABS Change spaces to tabs check box on 

Translation tab in the Site Properties

dialog box

TABS-TO-SPACES Change tabs to spaces check box on 

Translation tab in the Site Properties

dialog box

TIME-LOGGED-IN Connected at on the Information tab in

the Site Properties dialog box

TIME-SINCE-LOGIN Connected for on the Information tab in

the Site Properties dialog box

TIMEOUT-CONNECT Connect box on the Connection tab in

the Site Properties dialog box

TIMEOUT-SESSION Session box on the Connection tab in the

Site Properties dialog box

TRANSFER-8.3-CASE Set case of 8.3 file names box under 

Upload to server options on the Transfer

tab in the Site Properties dialog box

TRANSFER- DISPOSITION If File Exists command on the Tools

menu

TRANSFER-ELAPSED- TIME Last transfer time on the Information tab

in the Site Properties dialog box

TRANSFER-METHOD Transfer Method command on the Tools

menu

TRANSFER-SPEED Last transfer rate on the Information tab

in the Site Properties dialog box

TRANSLATE-FILES Translate files check box in Character

Sets dialog box

USE-PASSTHROUGH- SERVER Controlled by firewall configuration in the

Security Properties dialog box.
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SET Parameter Equivalent Interface Setting

USE-SOCKS Controlled by SOCKS configuration in the 

Security Properties dialog box.

USERNAME User box on General tab in the Site

Properties dialog box
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Site_Specific File Transfer SET Parameters

Advanced File Transfer SET Parameters

Transfer options when sending files to the server

CREATE-SERVER-UPPER

TRANSFER-8.3-CASE

Transfer options when receiving files from the server

PRESERVE-FILE-DATE

CREATE-8.3-FILENAMES

Character Translation SET Parameters for ASCII File Transfer

Character sets used for translations

ASCII-CLIENT-TYPE

ASCII-SERVER-TYPE

NATIONAL-REPLACEMENT-SET

Translation options when sending files to the server

MCS-TO-NRC

ROMAN8-TO-ISO7

Translation options when receiving files from the server

ISO7-TO-ROMAN8

NRC-TO-MCS

ASCII SERVER TYPE SET Parameter Values

The ASCII-SERVER-TYPE SET parameter <value>  can be any of the following:

SET Parameter Equivalent Interface Setting

WRITE-CTRLZ Write Ctrl-Z at end of file under From

server on Translation tab in Site

Properties dialog box

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

DEC-SUPPLEMENTAL ISO-LATIN-2 BIG-5 DEC-Hebrew
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NATIONAL-REPLACEMENT-SET Parameter Values

The NATIONAL-REPLACEMENT-SET SET parameter <value>  can be any of the following::

ISO-LATIN-1 ISO-LATIN-5 CCDC 7-Bit-Hebrew

PC-ENGLISH ISO-LATIN-6 GB-Chinese DEC-Cyrillic

PC-MULTILINGUAL ISO-LATIN-7 KS-5601-

Korean

HP-Turkish

HP-ROMAN-8 ISO-LATIN-8 HP-Greek DEC-Turkish

PC-SLAVIC ISO-LATIN-9 DEC-Greek PC-Spanish

PC-CYRILLIC-855 SHIFT-JIS PC-Greek PC-Turkish

PC-MODERN-TURKISH JIS-X0208-1990 YUASCII SBIG-5

PC-PORTUGUESE JIS-X0208-1983 PC-Cyrillic THAI-988-

TISO

PC-ICELANDIC JIS-C6226-1978 JIS-Katakana THAI-TISO

PC-CANADIAN-

FRENCH

DEC-1983-KANJI NEC-N88 THAI-KU

PC-ARABIC DEC-1978-KANJI PC-Hebrew THAI-PRIME

PC-NORDIC EUC HP-Hebrew HP-Hebrew

PC-MODERN-GREEK PC-MODERN-

GREEK

USASCII GERMAN

DANISH SWISS-GERMAN

DUTCH ITALIAN

CANADIAN-ENGLISH SPANISH-LATIN

FINNISH NORWEGIAN

FLEMISH PORTUGUESE

FRENCH SPANISH-EUROPEAN

CANADIAN-FRENCH SWEDISH
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ABORT-ON-ERROR Script Sample

This sample code sets ABORT-ON-ERROR to NO before using MGET and back to YES before using 

MDEL or PUT.

SWISS-FRENCH BRITISH

SET ABORT-ON-ERROR NO
CD /home/user1/reports
CONTINUE ON
MGET june*.rpt
CD /home/user2/reports
MGET june*.rpt
SET ABORT-ON-ERROR YES
MDEL june*.rpt
CD /home/user1/reports
MDEL june*.rpt
SET ABORT-ON-ERROR NO
CD /home/yearly
CONTINUE
MGET ye20*.rpt,ye20*.txt
SET ABORT-ON-ERROR YES
CD /tmp
PUT ye2000.txt
PUT ye2000.rpt ye2000.txt APPEND
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12.2.30 SITE

Syntax: site <argument>

FTP Command Index

The SITE command allows you to send a recognized SITE command to the server.

To find out what SITE commands are understood by the current FTP server, try entering this

command at the FTP command line:

If the server supports the QUOTE command, it may respond with a list the SITE commands that are

understood by the server. The server response displays in the command window.

Examples

The following command requests the idle timeout setting for the server:

The server response shows in the command window. For example:

This command sets the IDLE timeout to 1800 seconds:

12.2.31 SYSTEM

Syntax: system

FTP Command Index

The SYSTEM command displays information about the type of operating system used by the

current FTP server. The information displays in the FTP command window.

For example, if you entered SYSTEM at the FTP command line, the display might look like this:

QUOTE help site

<argument> Specifies any SITE command that the FTP server understands.

SITE idle

200 Current IDLE time limit is 900 seconds; max 7200

SITE idle 1800

215 UNIX Type: L8
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12.2.32 TYPE

Syntax: type <serverfile>

FTP Command Index

The TYPE command displays the contents of a server file in the FTP command window.

Example

The following command displays in the command window the file hardware.txt, which is located in

the /Users/boris folder on the FTP server:

12.2.33 VERIFY

Syntax: verify [commands] [<set parameter>] [changed]

FTP Command Index

The VERIFY command displays information about the values of one or more SET parameters. With

no parameters, VERIFY displays the current value of all Reflection SET parameters.

Examples

This command displays the current national replacement set setting:

This command creates a complete list of current SET parameter values:

<serverfile> Specifies the location and name of the server file. This specification

cannot contain wildcards.

TYPE /Users/boris/hardware.txt

<set parameter> Displays the value of a particular SETparameter.

VERIFY NATIONAL-REPLACEMENT-SET

VERIFY
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12.3 SFTP commands

12.3.1 SFTP commands

Available commands:

ASCII

BINARY

BYE

CD

CHMOD

EXIT

GET

LCD

LLS

LMKDIR

LPWD

LS

MGET

MKDIR

MPUT

PROGRESS

PUT

PWD

QUIT

RENAME

RM

RMDIR

SET

SMART

TENEX

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 

• • 
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12.3.2 ASCII

Syntax: ascii

FTP Command Index

SFTP Command Index

The ASCII command changes the current file transfer method to ASCII. Use this transfer method to

move ASCII text files between the server and your PC.

12.3.3 BINARY

Syntax: binary

FTP Command Index

SFTP Command Index

The BINARY command changes the current file transfer method to binary (image). Use this transfer

method to transfer binary files, such as .EXE files and compressed files, between two PCs (via a

server), or between two servers (via a PC).

12.3.4 BYE

Syntax: bye

SFTP Command Index

The BYE command closes the connection to the server.

This command is available for SFTP connections only.

• 

• 

• 

• 
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12.3.5 CD

Syntax: cd <server directory>

FTP Command Index

SFTP Command Index

The CD command changes the working directory on the FTP server.

Examples

This command changes to the directory "Asian Artists" on a UNIX system:

This command changes directories on a VAX/VMS system:

12.3.6 CHMOD

Syntax: chmod <numeric permission mask> <server file or directory>

FTP Command Index

SFTP Command Index

The CHMOD command changes the permissions associated with a file or directory.

• 

• 

<server directory> Specifies a directory on the server.

CD Asian Artists

CD SYS$USERS:[ARNOLD.DOCS]

• 

• 

<numeric 

permission 

mask>

Specifies a three digit numeral that is a valid value for the UNIX chmod

command. Valid values have digits from 0 to 7. Tip: To determine what

mask to use to set permissions, right click on a server file and select

properties. The properties dialog box displays the three digit mask and

the permissions associated with it. If you change the permissions, the

mask value is updated automatically.
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Example

This command sets attributes to -rw-r--r--  for the specified file.

12.3.7 EXIT

Syntax: exit

FTP Command Index

SFTP Command Index

The EXIT command closes the connection to the server.

12.3.8 GET

Syntax: get <serverfile> [to] [<clientfile>] [append | askuser | cancel | overwrite | 

skip | unique]

FTP Command Index

SFTP Command Index

The GET command transfers a file from the server to the PC. Wildcards are not supported with the 

GET command-they are treated as ordinary characters and are assumed to be part of the file name.

To transfer multiple files, use MGET.

Before using the GETcommand, if necessary, use the ASCII, BINARY, TENEX2, or SMART command

to override the default file transfer method setting specified on the Tools menu.

A variety of site-specific SET parameters can affect the transfer operation. Click here for more

information.

<server file 

or 

directory>

Specifies a file or directory on the FTP server. Follow the server's

syntax for specifying file and directory names.

chmod 644 myfile.htm

• 

• 

• 

• 

<serverfile> Specifies the name of the server file.

to <clientfile> Specifies the name of the PC file to be created. If this

option is omitted, the client file receives the same name

as the server file. The TO keyword is optional.
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Examples

The following example transfers the server file MEMO.DOC from the server to the PC, giving the PC

file the same name:

This example transfers the VAX/VMS FTP server file MORTGAGE.PAPERS to the PC, giving the PC

file the name MORTGAGE.TXT:

12.3.9 LCD

Syntax: lcd [<pc drive/folder> | ..]

FTP Command Index SFTP Command Index

The LCD command opens another folder on the PC.

If no <folder>  is specified, LCD displays the path for the current PC folder.

To change folders, type the folder at the FTP command line, for example, type LCD F:

\Documents and press Return.

append | askuser | 

cancel | overwrite | 

skip | unique

Specifies what to do if the destination file already exists.

If this option is omitted, the active TRANSFER-

DISPOSITION setting is the default.

GET MEMO.DOC

GET MORTGAGE.PAPERS MORTGAGE.TXT

<pc drive/

folder>

Specifies the drive (if other than the current drive) and folder to

change to.
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Example

This command changes your current folder to the China folder within the Asian Travel folder on

drive D:

12.3.10 LLS

Syntax: lls [<pc filespec>]

SFTP Command Index

The LLS command displays a listing of PC files matching the given filespec.

This command is available for SFTP connections only. The FTP equivalent is LDIR.

Example

This command displays a listing of files in the current PC folder that have a .Doc extension:

.. Specifies that you want to change to the parent folder.

LCD d:\Asian Travel\China

<pc 

filespec>

Specifies a folder, a file, or a group of files on the PC. If this option is not

used, the contents of the current PC folder are displayed.

LLS *.Doc
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12.3.11 LMKDIR

Syntax: lmkdir <pc directory>

SFTP Command Index

The LMKDIR command creates a folder on the PC.

This command is available for SFTP connections only. The FTP equivalent is LMD.

Example

This command creates the folder Music on the current PC drive:

12.3.12 LPWD

Syntax: lpwd [<pc drive/folder> | ..]

SFTP Command Index

The LPWD command opens another folder on the PC.

If no <folder>  is specified, LPWD displays the path for the current PC folder.

To change folders, type the folder at the FTP command line, for example, type LPWD F:\Documents

and press Return.

This command is available for SFTP connections only. The FTP equivalent is LCD.

<pc 

folder>

Specifies the drive where you want to create the folder (if other than the

current drive) and the folder name.

LMKDIR \Music

<pc drive/

folder>

Specifies the drive (if other than the current drive) and folder to

change to.
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Example

This command changes your current folder to the China folder within the Asian Travel folder on

drive D:

12.3.13 LS

Syntax: ls [<server filespec>]

FTP Command Index

The LS command displays a simple listing of server files matching the given filespec. (Compare

this to the DIR command, which displays a more detailed listing.)

Example

In this example, the names of all files in the current folder on a UNIX FTP server are listed:

.. Specifies that you want to change to the parent folder.

LPWD d:\Asian Travel\China

<server 

filespec>

Specifies a folder, file, or group of files on the server. If this option is

not used, the contents of the current server folder are displayed.

LS *.*
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12.3.14 MGET

Syntax: mget <server filespec> [to] [<pc filespec>] [append | askuser | cancel | 

overwrite | skip | unique]

FTP Command Index

SFTP Command Index

The MGET command transfers one or more files matching the given filespec from the FTP server

to the PC. You can use wildcards to transfer multiple files. Most servers support wildcards in the 

<serverspec> . However, if your server doesn't support wildcards in an LS command, using MGET

with a wildcard specification may result in a transfer of all files in the current directory.

Before using the MGET command, if necessary, use the ASCII, BINARY, TENEX, or SMART

command to override the default file transfer method setting specified on the Tools menu.

A variety of site-specific SET parameters can affect the transfer operation. Click here for more

information.

• 

• 

The Reflection client supports MGET in SFTP sessions, however you should test transfers that

use wildcard characters because the SFTP server may not interpret wildcard specifications

correctly.

note

<server filespec> Specifies one server file or (using server wildcards) multiple

server files to transfer to the PC. If a <server filespec> is

given with no other options, the PC files are given the same

names as the server files.

to <pc filespec> Specifies a PC folder to receive the files, or the name of the PC

file to create. The TO keyword is optional. If this option is

omitted, server files are transferred to the current folder.

If <server filespec>  specifies more than one file, the <pc 

filespec>  should typically be a directory path. To consolidate a

series of server files in one PC file, you can specify a file name

for the <pc filespec>  and use the APPEND option.

Use quotation marks if the file or path includes spaces. For

example:

MGET *.* "C:\My documents\*.*"
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Examples

This example transfers all files with a .Doc extension from the FTP server to the PC, placing the

files in the current PC directory:

This example adds the letter A to the transferred files. For example, test.txt becomes Atest.txt.

See ABORT_ON_ERROR Script Sample for an additional example.

12.3.15 MKDIR

Syntax: mkdir <server folder>

SFTP Command Index

The MKDIR command creates a folder on the server.

This command is available for SFTP connections only. The FTP equivalent is MD.

Example

This command creates the folder Films within the current folder on the current FTP UNIX server

drive:

append | askuser | 

cancel | overwrite 

| skip | unique

Specifies what to do if the destination file already exists. If this

option is omitted, the active TRANSFER-DISPOSITION setting is

the default.

MGET *.Doc

MGET *.* A*.*

<server folder> Specifies the name and location of the new folder.

MKDIR Films
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12.3.16 MPUT

Syntax: mput <pc filespec> [to] [<server filespec>] [append | askuser | cancel | 

overwrite | skip | unique]

FTP Command Index

SFTP Command Index

The MPUT command transfers one or more files matching the given filespec from the PC to the

FTP server. You can use wildcards to transfer multiple files.

Before using the MPUT command, if necessary, use the ASCII, BINARY, TENEX, or SMART

command to override the default file transfer method setting specified on the Tools menu.

A variety of site-specific SET parameters can affect the transfer operation. Click here for more

information.

• 

• 

The Reflection client supports MPUT in SFTP sessions, however you should test transfers that

use wildcard characters because the SFTP server may not interpret wildcard specifications

correctly.

note

<pc filespec> Specifies one PC file or (using wildcards) multiple PC files to

transfer to the server. The files are placed in the current server

directory and are given the same names as the PC files.

PC wildcard characters ( the ? and * characters) can be used to

send multiple files to the server. For example, to send all files in

the current directory with the file extension .Txt , use the

command MPUT *.Txt .

Use quotation marks if the file or path includes spaces. For

example:

MPUT "C:\My documents\*.*"

to <server 

filespec>

Specifies a server file or (using server wildcards) multiple server

files to receive the PC files. If files of this name don't exist, they

are created by the transfer. If no value for <server filespec>  is

given, server files are given the same name as the PC files.

The TO keyword is optional.
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Examples

The following example transfers files in the Meeting Notes folder within the current folder on the

PC that have a .Doc extension , placing the files in the current server folder. Source PC files that

have the same name as files in the destination server folder are not transferred.

The following example adds the letter "A" to the front of files transferred to the server. For example

Sample.htm becomes ASample.htm.

The final example removes file extensions from PC files copied to the server:

12.3.17 PROGRESS

Syntax: progress

SFTP Command Index

Toggles the display of the progress meter.

This command is available for SFTP connections only.

append | askuser 

| cancel | 

overwrite | skip 

| unique

Specifies what to do if the destination file already exists. If this

option is omitted, the active TRANSFER-DISPOSITION setting is

the default.

MPUT "Meeting Notes\*.Doc" skip

MPUT *.htm A*.htm

MPUT *.*  *.
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12.3.18 PUT

Syntax: put <clientfile> [to] [<serverfile>] [append | askuser | cancel | overwrite | 

skip | unique]

FTP Command Index

SFTP Command Index

The PUT command transfers a file from the PC to the server.

Wildcards are not supported with the PUT command; to transfer multiple files using wildcards, use 

MPUT.

Before using the PUT command, if necessary, use the ASCII, BINARY, TENEX, or SMART command

to override the default file transfer method setting specified on the Tools menu.

A variety of site-specific SET parameters can affect the transfer operation. Click here for more

information.

• 

• 

<clientfile> Specifies the name of the PC file. Use quotation marks if

the file or path includes spaces.

to <serverfile> Specifies the name of the server file to be created. If the

server file name is omitted, the server file is given the

same name as the PC file. The TO keyword is optional.
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Examples

The following example transfers the file Memo.doc  from the PC to the server:

This example transfers the file HAPPY.ME  from a PC to a VAX/VMS FTP server, giving the VMS file

the name HAPPY.BIRTHDAY:

See ABORT_ON_ERROR Script Sample for an additional example.

12.3.19 PWD

Syntax: pwd

FTP Command Index

SFTP Command Index

The PWD command shows the server folder that is currently open. The name and location of the

folder display in the FTP command window.

12.3.20 QUIT

Syntax: quit

FTP Command Index

SFTP Command Index

The QUIT command closes the connection to the server.

append | askuser | 

cancel | overwrite | 

skip | unique

Specifies what to do if the destination file already exists. If

this option is omitted, the active TRANSFER-DISPOSITION

setting is the default.

PUT Memo.doc

PUT HAPPY.ME TO HAPPY.BIRTHDAY

• 

• 

• 

• 

When you run a script from the Windows command line using the /RFS  switch and the script

ends in with a QUIT command, the FTP client shuts down automatically when the script is

complete.

note
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12.3.21 RENAME

Syntax: rename <server filename> <new filename>

FTP Command Index

SFTP Command Index

The RENAME command changes the name of a server file to the new name specified. On some

servers, you can use RENAME to specify both a new name and a new location for the file. In this

case, the file is moved to the new location and given the new name specified.

• 

• 

<server 

filename>

Specifies the name of the server file you want to rename. The

specification can include the name of the server folder where the file is

located. Use quotation marks if the file or path includes spaces. For

example: "/Maps/North America" .
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Example

In the current folder on the server, this command renames the file "Map of Canada" to "Canada":

From the "Maps" folder on the server , this command renames a file in the folder "Europe", changing

the name from "England" to "Great Britain".

<new 

filename>

Specifies the name you want to give the file. Use quotation marks if the

file or path includes spaces. For example: 

"D:\To do\Work assignments"

On some servers, if you omit the path to the file you are renaming, the file

is moved to the current server folder and given the new name. If you

want to use RENAME to move a file, specify a new location and file

name.

RENAME "Map of Canada" Canada

RENAME /Maps/Europe/England "/Maps/Europe/Great Britain"
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12.3.22 RM

Syntax: rm <serverfile>

SFTP Command Index

The RM command deletes a file matching the given filespec on the SFTP server.

This command is available for SFTP connections only. The FTP equivalent is DELETE.

Example

This command deletes MEMO.DOC from the current server directory:

If the SET parameter CONFIRM-DELETE is set to YES, the user is prompted for confirmation

before deleting.

note

<serverfile> Specifies the name of a server file to delete. This can include a full

directory path to the file. On some systems case is important when

specifying directories and file names.

RM MEMO.DOC
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12.3.23 RMDIR

Syntax: rmdir <server folder>

SFTP Command Index

The RMDIRcommand deletes an empty folder on the server.

This command is available for SFTP connections only.

Example

This command deletes the folder Articles from the current server folder:

If the SET parameter CONFIRM-DELETE is set to YES, the user is prompted for confirmation

before deleting.

note

<server 

folder>

Specifies the location and name of the folder you want to delete. The 

<server folder> specification must follow the conventions of the server

operating system. Before you can delete a folder, you must delete the files

and folders within it.

RMDIR Articles
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12.3.24 SET

Syntax: set <set parameter> <value>

FTP Command Index

SFTP Command Index

Use the SETcommand to configure Reflection. See the SET Parameters for a list of available

options.

Examples

These commands initialize various file transfer parameters:

More information

SET Parameter Reference

SET Parameters and Equivalent Interface Settings

Site-Specific File Transfer SET Parameters

12.3.25 SMART

Syntax: smart

FTP Command Index SFTP Command Index

The SMART command changes the current FTP file transfer method to Smart.

Use the Smart transfer method if you want the FTP Client to automatically determine what transfer

method to use (ASCII, Binary, or Tenex) based on the type of file that is being transferred. The FTP

Client uses the source file extension to determine what type of file is being transferred. To set up

for Smart File Transfer, use settings on the File Types tab in the Options dialog box.

• 

• 

SET TABS-TO-SPACES NO
SET TRANSFER-DISPOSITION Overwrite
SET TRANSFER-METHOD Ascii
SET TRANSLATE-FILES NO

• • 

• • 

• • 
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12.3.26 TENEX

Syntax: tenex

FTP Command Index

SFTP Command Index

The TENEX command changes the current file transfer method to "local 8." Use this transfer

method if you're moving files to or from a server that uses a non-8-bit byte (such as the

DECsystem-20).

13. Legal Notice
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